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0.2 Περίληψη
Η τοπολογική βελτιστοποίηση είναι μια μαθηματική μέθοδος που βελ-

τιστοποιεί τη διάταξη του υλικού μέσα σε ένα δεδομένο σχεδιαστικό χω-
ρίο, για δεδομένο σύνολο φορτίσεων και οριακών συνθηκών, έτσι ώστε
η προκύπτουσα διάταξη να πληρεί ένα προκαθορισμένο σύνολο στόχων.
Στην παρούσα διπλωματική εργασία σχεδιάστηκε και βελτιστοποιήθηκε
τοπολογικά ρότορας ανεμογεννήτριας οριζόντιου άξονα, με ονομαστική
ισχύ 10𝑘𝑊 . Ο ρότορας αποτελεί ένα από τα βαρύτερα εξαρτήματα μιας
ανεμογεννήτριας, λόγω του υλικού από το οποίο είναι κατασκευασμέ-
νος, με μεγάλο κόστος κατά την μεταφορά του. Σκοπός της παρούσας
εργασίας είναι η αφαίρεση υλικού από τον ρότορα, για τη μείωση του
βάρους όσο και του κόστους παραγωγής του, χωρίς την μείωση της αντο-
χής του σε φορτίσεις. Όλες οι φορτίσεις προκαλούμενες από τον αέρα
και την αδράνεια στις πτέρυγες έχουν μεταφερθεί στο ρότορα και εί-
ναι προσεγγιστικές. Επίσης, οι διαστάσεις που χρησιμοποιήθηκαν εί-
ναι και αυτές προσεγγιστικές λόγω της ελλειπής διαθέσιμης βιβλιογρα-
φίας. Ο σχεδιασμός του ρότορα πραγματοποιήθηκε με το CAD λογι-
σμικό Pro/ENGINEER Wildfire 5.0 ενώ η τοπολογική βελτιστοποίηση,
με τη χρήση του λογισμικού ABAQUS/CAE 6.12. Στο περιβάλλον αυτό
μελετήθηκε η κατανομή των τάσεων von Mises πρίν και μετά την αφαί-
ρεση υλικού από το αρχικό μοντέλο. Τα εξερχόμενα αποτελέσματα από
το CAE λογισμικό αποτέλεσαν βάση για την, εξ αρχής, μοντελοποίηση
του βελτιστοποιημένου ρότορα. Η μοντελοποίηση αυτή πραγματοποιή-
θηκε με τη χρήση του προγράμματος Creo Parametric. Στο παράρτημα
παρουσιάζεται αναλυτικά μια απλή εφαρμογή σχεδιασμού, τοπολογικής
βελτιστοποίησης και επαλήθευσης μιας γέφυρας, για λόγους εκπαιδευτι-
κούς. Tα αποτελέσματα της παρούσας εργασία μπορούν να χρησιμοποι-
ηθούν για την εφαρμογή τοπολογικής βελτιστοποίησης σε μεγάλο φάσμα
εξαρτημάτων και κατασκευών.
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Κεφάλαιο 1

Τεχνική ανάλυση
ανεμογεννήτριας

1.1 Ιστορική αναδρομή
Η δύναμη του ανέμου μπορεί να γίνει πολύ ισχυρή, όπως είναι φανερό

μετά το πέρασμα ενός τυφώνα. Ιστορικά, η δύναμη αυτή αξιοποιήθηκε
από τον άνθρωπο και ίσως η πιο σημαντική χρήση της είναι η προώθηση
των πλοίων, χρησιμοποιώντας πανιά, πρίν την εφεύρεση της ατμομη-
χανής και της μηχανής εσωτερικής καύσης. Επίσης, έχει χρησιμοποιη-
θεί σε ανεμόμυλους για το άλεσμα του σιταριού ή την άντληση νερού.
Στις αρχές του εικοστού αιώνα οι ανεμόμυλοι αντικαταστάθηκαν από
τις ανεμογεννήτριες, καθώς σταδιακά ο ρότορας συνδέθηκε με την ηλε-
κτική γεννήτρια. Με την πετρελαική κρίση του 1973, πολλές χώρες που
ήθελαν να είναι λιγότερο εξαρτημένες απο τις εισαγωγές πετρελαίου άρ-
χισαν να ερευνούν τις δυνατότητες της αιολικής ενέργειας. Έκτοτε μέχρι
και σήμερα το ενδιαφέρον όλο και περισσότερων χωρών και εταιρειών
κεντρίζεται για τις προοπτικές ανάπτυξης βέλτιστων ανεμογεννητριών
[6].

1.2 Τεχνικά χαρακτηριστικά
Σήμερα, κυκλοφορεί στο εμπόριο μεγάλο εύρος ανεμογεννητριών για

την ικανοποίηση όλο και περισσότερων αναγκών. Στην παρούσα εργα-
σία χρησιμοποιήθηκε ανεμογεννήτρια οριζόντιου άξονα με τρία πτερύ-
για [1]. Στον παρακάτω πίνακα παρουσιάζονται κάποια βασικά τεχνικά
χαρακτηριστικά της πρός ανάλυση ανεμογεννήτριας, καθώς τα μεγέθη
τους κυμαίνονται σε μεγάλο εύρος, σύμφωνα με την ονομαστική τους
ισχύ. Είναι σημαντικό να αναφερθεί ότι τα στοιχεία αυτά είναι ενδει-
κτικά και επομένως τα αποτελέσματα αναμένονται να είναι και αυτά
προσεγγιστικά, καθότι σκοπός της παρούσας εργασίας δεν είναι η ακρι-

1
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βής αποτύπωση και ανάλυση κάποιας συγκεκριμένης ανεμογεννήτριας,
αλλά η παρουσίαση της τοπολογικής βελτιστοποίησης ώς ένα εργαλείο
βελτιστοποίησης σχεδιασμού, με εφαρμογή τον βέλτιστο σχεδιασμό του
ρότορα μιας ανεμογεννήτριας.

Εικόνα 1.1: Aνεμογεννήτρια οριζόντιου άξονα.

ΠΙΝΑΚΑΣ ΤΕΧΝΙΚΩΝ ΧΑΡΑΚΤΗΡΙΣΤΙΚΩΝ
Ονομαστική Ισχύς (KW) 10
Ονομαστική ταχύτητα (m/s) 11
Aριθμός πτερυγίων 3
Διάμετρος ρότορα D (m) 7
Βάρος πτέρυγας (kg) 40
Tαχύτητα αέρα κατά την εκκίνηση (m/s) 2.5
Tαχύτητα αέρα στην αρχή του φρεναρίσματος (m/s) 25
Ύψος πύργου ανεμογεννήτριας H (m) 10

Πίνακας 1.1: Πίνακας τεχνικών χαρακτηριστικών ανεμογεννήτριας.

1.3 Κατηγορίες φόρτισης.

1.3.1 Βαρυτικές δυνάμεις και ροπές
Τα εξωτερικά φορτία που ενεργούν σε μια ανεμογεννήτρια είναι κυ-

ρίως φορτία προερχόμενα από τον άνεμο. Καθώς η ανεμογεννήτρια απο-
τελείται από λεπτά στοιχεία, όπως τις λεπίδες και τον πύργο, αναμένεται
να αναπτυχθούν φορτία αδράνειας τα οποία προστίθενται στα βαρυτικά
φορτία που ενεργούν στα στοιχεία αυτά. Στην παρούσα εργασία τα κύ-
ρια φορτία που οφείλονται στη λειτουργία της ανεμογεννήτριας θεωρή-
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θηκαν τα βαρυτικά φορτία με αποτέλεσμα να αμελούνται οι φυγόκεντρες
δυνάμεις και οι δυνάμεις Coriolis όπως και τα γυροσκοπικά φορτία λόγω
τάσεων αποσταθεροποίησης, κατά την περιστροφή. Η βαρυτική δύναμη
δίδεται ώς:

𝐺 =
𝑛
􏾜
𝑖=􏷠
𝑚𝑖𝑔 ή 𝐺 = 𝑚𝑏𝑙𝑎𝑑𝑒𝑔 (1.1)

όπου 𝑔 = 9.81𝑚/𝑠􏷡 η επιτάχυνση της βαρύτητας, 𝑚𝑖 η στοιχειώδης μάζα
και 𝑚𝑏𝑙𝑎𝑑𝑒 η συνολική μάζα της πτέρυγας.

Το βάρος των πτερυγίων προκαλεί καμπτικές ροπές στις λεπίδες
πρός την πλάγια κατεύθυνση. Όμως, λόγω της περιστροφής των πτερυ-
γίων τα βαρυτικά φορτία προκαλούν κυκλικά διαφορετικές ροπές κάμ-
ψης. Όσο μεγαλύτερη είναι η διάμετρος του ρότορα, τόσο μεγαλύτερη η
επίδραση των φορτίων αυτών. Η καμπτική ροπή λόγω βαρυτικών φορ-
τίσεων βρίσκεται από την παρακάτω σχέση

Μ = 𝐺𝑙 (1.2)

όπου 𝐺 η βαρυτική δύναμη και 𝑙 η κάθετη απόσταση του κέντρο πε-
ριστροφής από τον φορέα της δύναμης. Θεωρείται ότι η δύναμη ασκείται
στο μισό του μήκους της πτέρυγας. Έτσι, βρίσκεται ότι η βαρυτική δύ-
ναμη για κάθε πτέρυγα είναι 𝐺 = 40 ∗ 9.81 = 392.4 𝑁, ενώ η καμπτική
ροπή 𝑀 = 𝐺 􏷢.􏷤

􏷡 = 686.7 𝑁𝑚.

1.3.2 Δύναμη και ροπή πέδησης
Αδρανειακή φόρτιση εμφανίζεται όταν ο στρόβιλος επιταχύνεται ή

επιβραδύνεται. Ένα τέτοιο παράδειγμα είναι η πέδηση του ρότορα [5]
(braking) όπου μια ροπή Μ𝑏 εφαρμόζεται σε κάποιον άξονα του ρότορα.
Έτσι, εφαρμόζεται στην πτέρυγα μια δύναμη αντίθετη της κατεύθυνσης
περιστροφής. Θεωρείται μια στοιχειώδης επιφάνεια στην οποία εφαρ-
μόζεται η δύναμη. Το μέγεθος του dF βρίσκεται από

𝑑𝐹 = 𝜔̇𝑟𝑚𝑑𝑟 (1.3)

όπου m ορίζεται η μάζα ανά μονάδα μήκους πτέρυγας, r η ακτίνα
από τον άξονα περιστροφής και dr το στοιχειώδης επιφάνεια. Επίσης,
ορίζεται ότι

𝜔̇ = d𝜔
d𝑡 (1.4)

Επομένως,

𝐼 d𝜔d𝑡 = Μ𝑏 (1.5)
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όπου I η ροπή αδράνειας του ρότορα. Αν θεωρήσουμε ότι ο ρότορας
περιστρέφεται με 11m/s και ο χρόνος πέδησης μέχρι την ακινητοποίησή
του είναι 60 sec βρίσκουμε ότι η δύναμη πέδησης 𝑏 = 𝜔̇ 𝑟􏷫

􏷡𝑚 = 12.8𝑁, ενώ
η ροπή πέδησης Μ𝑏 = 𝑏 􏷢.􏷤􏷡 = 22.4𝑁𝑚.

Εικόνα 1.2: Δύναμη και ροπή πέδησης.

1.3.3 Μετωπική δύναμη αέρα.
Η δύναμη του αέρα υπολογίστηκε προσεγγιστικά ώς μια ομοιόμορφη

δύναμη P, που ασκείται κάθετα στην μετωπική επιφάνεια του ρότορα.
To μέτρο της δύναμης αυτής τίθεται 100 𝑁 . Αντίθετα με τις βαρυτικές
δυνάμεις και ροπές και τις ροπές λόγω πέδησης, η δύναμη P δεν μετα-
βάλλεται με την περιστροφή του ρότορα. Για τις ανάγκες της ανάλυσης
δημιουργήθηκε το διάγραμμα ελευθέρου σώματος σε πέντε ξεχωριστές
θέσεις φόρτισης στις 0, 30, 45, 60, 90 μοίρες, όπως παρουσιάζεται στην
Εικόνα 1.3.

1.4 Περιπτώσεις φόρτισης.
Ώς μέρος της διαδικασίας σχεδιασμού μιας ανεμογεννήτριας θεωρεί-

ται η ανάλυση των δυνάμεων για διάφορες περιπτώσεις φόρτισης που
πρόκειται να αντιμετωπίσει κατά τη διάρκεια της ζωής της και η τυπική
διάρκεια ζωής μιας ανεμογεννήτριας ξεπερνά τα 20 χρόνια. Για τις ανά-
γκες της παρούσας εργασίας δημιουργήθηκαν δέκα περιπτώσεις φόρτι-
σης δύο για κάθε θέση περιστροφής (στις 0, 30, 45, 60, 90 μοίρες), κατά
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(αʹ) 0 μοίρες. (βʹ) 30 μοίρες.

(γʹ) 45 μοίρες.

(δʹ) 60 μοίρες. (εʹ) 90 μοίρες.

Εικόνα 1.3: Εφαρμογή δυνάμεων σε διάφορες μοίρες κατά την περιστροφή
του ρότορα.
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Κατάλογος Φορτίσεων
Α/Α Είδος δύναμης Πτέρυγα Μοίρες
1 Βαρυτική δύναμη 1 0
2 Βαρυτική δύναμη 2 0
3 Βαρυτική δύναμη 3 0
4 Βαρυτική δύναμη 1 30
5 Βαρυτική δύναμη 2 30
6 Βαρυτική δύναμη 3 30
7 Βαρυτική δύναμη 1 45
8 Βαρυτική δύναμη 2 45
9 Βαρυτική δύναμη 3 45
10 Βαρυτική δύναμη 1 60
11 Βαρυτική δύναμη 2 60
12 Βαρυτική δύναμη 3 60
13 Βαρυτική δύναμη 1 90
14 Βαρυτική δύναμη 2 90
15 Βαρυτική δύναμη 3 90
16 Καμπτική ροπή λόγω βαρύτητα 1 -
17 Καμπτική ροπή λόγω βαρύτητα 2 -
18 Καμπτική ροπή λόγω βαρύτητα 3 -
19 Δύναμη πέδησης 1 -
20 Δύναμη πέδησης 2 -
21 Δύναμη πέδησης 3 -
22 Καμπτική ροπή λόγω δύναμης πέδησης 1 -
23 Καμπτική ροπή λόγω δύναμης πέδησης 2 -
24 Καμπτική ροπή λόγω δύναμης πέδησης 3 -
25 Δύναμη αέρα - -

Πίνακας 1.2: Πίνακας φορίσεων.

την ομαλή λειτουργία και κατά την πέδηση. Κατά την ομαλή λειτουρ-
γία της ανεμογεννήτριας, σε καθεμιά από τις πέντε θέσεις περιστροφής,
εφαρμόζονται οι βαρυτικές δυνάμεις, οι καμπτικές ροπές καθώς και η
ομοιόμορφη δύναμη του αέρα. Αντίστοιχα, κατά την πέδηση της ανεμο-
γεννήτριας στις παραπάνω δυνάμεις προστίθενται και οι δυνάμεις και
οι ροπές πέδησης για καθεμιά από τις πέντε θέσεις.

Οι δυνάμεις αυτές θα χρησιμοποιηθούν για να οριστούν οι περιπτώ-
σεις φόρτισης. Κατά την μοντελοποίηση δημιουργήθηκαν δέκα περιπτώ-
σεις φόρτισης, σε κανονικές συνθήκες λειτουργία και σε έντονα φαινό-
μενα, για καθεμιά απο τις πέντε θέσεις περιστροφής. Η διαφορά των
ήπιων από τα έντονα φαινόμενα έγκειται στο γεγονός της εφαρμογής
των δυνάμεων πέδησης καθώς και των αντίστοιχων καμπτικών ροπών
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στην προσπάθεια ελάττωσης της ταχύτητας περιστροφής της ανεμογεν-
νήτριας για την αποφυγεί ατυχήματος.

Κατάλογος περιπτώσεων Φορτίσης (1 από 3)
Είδος δύναμης Πτέρυγα
ΚΑΝΟΝΙΚΕΣ ΣΥΝΘΗΚΕΣ ΛΕΙΤΟΥΡΓΙΑΣ ΣΤΙΣ 0 ΜΟΙΡΕΣ
Βαρυτική δύναμη 1
Βαρυτική δύναμη 2
Καμπτική ροπή λόγω βαρύτητα 1
Καμπτική ροπή λόγω βαρύτητα 2
Καμπτική ροπή λόγω βαρύτητα 3
Δύναμη αέρα -
ΚΑΝΟΝΙΚΕΣ ΣΥΝΘΗΚΕΣ ΛΕΙΤΟΥΡΓΙΑΣ ΣΤΙΣ 30 ΜΟΙΡΕΣ
Βαρυτική δύναμη 1
Βαρυτική δύναμη 2
Βαρυτική δύναμη 3
Καμπτική ροπή λόγω βαρύτητα 1
Καμπτική ροπή λόγω βαρύτητα 2
Καμπτική ροπή λόγω βαρύτητα 3
Δύναμη αέρα -
ΚΑΝΟΝΙΚΕΣ ΣΥΝΘΗΚΕΣ ΛΕΙΤΟΥΡΓΙΑΣ ΣΤΙΣ 45 ΜΟΙΡΕΣ
Βαρυτική δύναμη 1
Βαρυτική δύναμη 2
Βαρυτική δύναμη 3
Καμπτική ροπή λόγω βαρύτητα 1
Καμπτική ροπή λόγω βαρύτητα 2
Καμπτική ροπή λόγω βαρύτητα 3
Δύναμη αέρα -
ΚΑΝΟΝΙΚΕΣ ΣΥΝΘΗΚΕΣ ΛΕΙΤΟΥΡΓΙΑΣ ΣΤΙΣ 60 ΜΟΙΡΕΣ
Βαρυτική δύναμη 1
Βαρυτική δύναμη 2
Βαρυτική δύναμη 3
Καμπτική ροπή λόγω βαρύτητα 1
Καμπτική ροπή λόγω βαρύτητα 3
Δύναμη αέρα -
ΚΑΝΟΝΙΚΕΣ ΣΥΝΘΗΚΕΣ ΛΕΙΤΟΥΡΓΙΑΣ ΣΤΙΣ 90 ΜΟΙΡΕΣ
Βαρυτική δύναμη 1
Βαρυτική δύναμη 2
Βαρυτική δύναμη 3
Καμπτική ροπή λόγω βαρύτητα 1
Καμπτική ροπή λόγω βαρύτητα 2
Καμπτική ροπή λόγω βαρύτητα 3
Δύναμη αέρα -
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Κατάλογος Περιπτώσεων Φορτίσης (2 από 3)
Είδος δύναμης Πτέρυγα

ENTONA ΦΑΙΝΟΜΕΝΑ ΣΤΙΣ 0 ΜΟΙΡΕΣ
Βαρυτική δύναμη 1
Βαρυτική δύναμη 2
Βαρυτική δύναμη 3
Καμπτική ροπή λόγω βαρύτητα 1
Καμπτική ροπή λόγω βαρύτητα 2
Δύναμη πέδησης 1
Δύναμη πέδησης 2
Δύναμη πέδησης 3
Καμπτική ροπή λόγω δύναμης πέδησης 1
Καμπτική ροπή λόγω δύναμης πέδησης 2
Καμπτική ροπή λόγω δύναμης πέδησης 3
Δύναμη αέρα -

ENTONA ΦΑΙΝΟΜΕΝΑ ΣΤΙΣ 30 ΜΟΙΡΕΣ
Βαρυτική δύναμη 1
Βαρυτική δύναμη 2
Βαρυτική δύναμη 3
Καμπτική ροπή λόγω βαρύτητα 1
Καμπτική ροπή λόγω βαρύτητα 2
Καμπτική ροπή λόγω βαρύτητα 3
Δύναμη πέδησης 1
Δύναμη πέδησης 2
Δύναμη πέδησης 3
Καμπτική ροπή λόγω δύναμης πέδησης 1
Καμπτική ροπή λόγω δύναμης πέδησης 2
Καμπτική ροπή λόγω δύναμης πέδησης 3
Δύναμη αέρα -

ENTONA ΦΑΙΝΟΜΕΝΑ ΣΤΙΣ 45 ΜΟΙΡΕΣ
Βαρυτική δύναμη 1
Βαρυτική δύναμη 2
Βαρυτική δύναμη 3
Καμπτική ροπή λόγω βαρύτητα 1
Καμπτική ροπή λόγω βαρύτητα 2
Καμπτική ροπή λόγω βαρύτητα 3
Δύναμη πέδησης 1
Δύναμη πέδησης 2
Δύναμη πέδησης 3
Καμπτική ροπή λόγω δύναμης πέδησης 1
Καμπτική ροπή λόγω δύναμης πέδησης 2
Καμπτική ροπή λόγω δύναμης πέδησης 3
Δύναμη αέρα -



Κατάλογος Περιπτώσεων Φορτίσης (3 από 3)
Είδος δύναμης Πτέρυγα

ENTONA ΦΑΙΝΟΜΕΝΑ ΣΤΙΣ 60 ΜΟΙΡΕΣ
Βαρυτική δύναμη 1
Βαρυτική δύναμη 2
Βαρυτική δύναμη 3
Καμπτική ροπή λόγω βαρύτητα 1
Καμπτική ροπή λόγω βαρύτητα 3
Δύναμη πέδησης 1
Δύναμη πέδησης 2
Δύναμη πέδησης 3
Καμπτική ροπή λόγω δύναμης πέδησης 1
Καμπτική ροπή λόγω δύναμης πέδησης 2
Καμπτική ροπή λόγω δύναμης πέδησης 3
Δύναμη αέρα -

ENTONA ΦΑΙΝΟΜΕΝΑ ΣΤΙΣ 90 ΜΟΙΡΕΣ
Βαρυτική δύναμη 1
Βαρυτική δύναμη 2
Βαρυτική δύναμη 3
Καμπτική ροπή λόγω βαρύτητα 1
Καμπτική ροπή λόγω βαρύτητα 2
Καμπτική ροπή λόγω βαρύτητα 3
Δύναμη πέδησης 1
Δύναμη πέδησης 2
Δύναμη πέδησης 3
Καμπτική ροπή λόγω δύναμης πέδησης 1
Καμπτική ροπή λόγω δύναμης πέδησης 2
Καμπτική ροπή λόγω δύναμης πέδησης 3
Δύναμη αέρα -

Πίνακας 1.3: Πίνακας περιπτώσεων φόρτισης.
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Κεφάλαιο 2

Περί τοπολογικής
βελτιστοποίησης

2.1 Εισαγωγή
Η τοπολογική βελτιστοποίηση είναι μια μαθηματική μέθοδος που βελ-

τιστοποιεί τη διάταξη του υλικού μέσα σε ένα δεδομένο σχεδιαστικό χω-
ρίο, για δεδομένο σύνολο φορτίσεων και οριακών συνθηκών, έτσι ώστε
η προκύπτουσα διάταξη να πληρεί ένα προκαθορισμένο σύνολο στόχων.
Χρησιμοποιώντας την τοπολογική βελτιστοποίηση οι μηχανικοί μπορούν
να βρούν τον καλύτερο σχεδιασμό που να πληρεί τις απαιτήσεις της
ανάλυσης. Η τοπολογική βελτιστοποίηση υλοποιείται με τη χρήση των
πεπερασμένων στοιχείων καθώς και των τεχνικών βελτιστοποίησης που
βασίζονται στη μέθοδο των κινούμενων ασύμπτωτων, γενετικών αλγο-
ρίθμων, μέθοδο κριτηρίων βέλτιστου κ.α.[2]

Η βασική ιδέα για λύση προβλημάτων κατανομής υλικού προήλθε
από τον Michell [7] στις αρχές το 1904. Ο Michell επικεντρώθηκε στον
σχεδιασμό κατασκευών από λεπτές ράβδους θέτοντας ως όριο σχεδια-
σμού την πλαστική μηχανική απόκριση του υλικού. Η μελέτη αυτή είχε
βασιστεί σε αναλυτικές μεθόδους. Αρκετά αργότερα, οι μέθοδοι μαθη-
ματικού προγραμματισμού, και πιο συγκεκριμένα, τεχνικές γραμμικού
προγραμματισμού και η μέθοδος simplex εφαρμόστηκαν σε προβλήματα
ελαχιστοποίησης του βάρους κατασκευών με δοκούς, με περιορισμούς
τάσεων. Χρησιμοποιώντας ως μεταβλητή σχεδιασμού το εμβαδόν της
διατομή της δοκού, το πρόβλημα εύρεσης της βέλτιστης θέσης της όταν
η κατασκευή υπόκειται σε ένα και μόνο φορτίο, μπορεί να επιλυθεί χρη-
σιμοποιώντας γραμμικό προγραμματισμό. Η τοπολογία καθορίζει ποιοι
από τους κόμβοι είναι συνδεδεμένοι μεταξύ τους με δοκούς, από ένα ευ-
ρύτερο χωρίο σχεδιασμού που αποτελείται από ένα δίκτυο κόμβων και
πιθανών ράβδων. Με την χρήση ενός αρκετά πυκνού αρχικού δικτύου
δοκών (structural universe) τα προκύπτοντα βέλτιστα δικτυώματα κατά

11
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Michell προσδιορίζονται τελικώς με την χρήση κλασσικών τεχνικών βέλτι-
στου σχεδιασμού. Οι ράβδοι δοκοί που δεν χρειάζονται στην τελική θέση
αφαιρούνται και τελικώς προκύπτει η ζητούμενη τοπολογία. Η ιδέα δια-
κριτοποίησης του αρχικού χωρίου σχεδιασμού σε κόμβους και ράβδους
χρησιμοποιήθηκε στην περίπτωση όπου το χωρίο σχεδιασμού καλύπτεται
από ένα συνεχές φυσικό μέσο. Μερικές από τις βασικές ιδέες αποσαφηνί-
στηκαν από θεωρητικές εργασίες που σχετίζονται με την ύπαρξη λύσης
και την εφαρμογή τεχνικών ομογενοποίησης για τον καλύτερο ορισμό
των προβλημάτων. Οι συγκεκριμένες εργασίες με την σειρά τους έγιναν
η βάση για την χρήση υπολογιστικών μεθόδων, τεχνικών διανομής υλι-
κού, οι οποίες δουλεύουν με παραμετροποίηση σχεδιασμού και επιτρέ-
πουν τον υπολογισμό της βέλτιστης κατανομής υλικού σε ένα συγκεκρι-
μένο και εξαρχής ορισμένο χωρίο σχεδιασμού. Ενώ στις πρώτες εργασίες
χρησιμοποιήθηκαν επαναληπτικές μεθόδους που βασίζονται στην χρήση
μεθόδων κριτηρίων βελτίστου (optimality criteria methods) (M.P Bendsoe
& Kikuchi [8]) σήμερα οι περισσότερες μέθοδοι διανομής υλικού βασίζο-
νται σε τεχνικές μαθηματικού προγραμματισμού μαζί με χρήση τεχνικών
ανάλυσης με πεπερασμένα στοιχεία. Αυτό σημαίνει ότι οι θεμελιώδεις
τεχνικές επίλυσης των μεθόδων διανομής υλικού μοιάζουν αρκετά με τις
μεθόδους που αναπτύχθηκαν για διαστασιολογική βελτιστοποίηση, αλλά
με ένα ευρύ φάσμα πολυπλοκότητας που σχετίζεται με την ειδική πα-
ραμετροποίηση που θα πρέπει να γίνει για τον σχεδιασμό τοπολογίας.
Ιδιαίτερη προσοχή θα πρέπει να δίνεται στον ορισμό προβλημάτων τοπο-
λογικής βελτιστοποίησης ειδικά όταν πρόκειται για προβλήματα μεγάλης
κλίμακας.

H τοπολογική βελτιστοποίηση χρησιμοποιείται στο στάδιο της σύλ-
ληψης της ιδέας που θα καταλήξει σε μια σχεδιαστική δομή που πληρεί
τις προυποθέσεις του αρχικού προβλήματος. Η διαδικασία αυτή αντικα-
θιστά τις χρονοβόρες και δαπανηρές επαναλήψεις στο σχεδιασμό και ώς
εκ τούτου μειώνει το χρόνο ανάπτυξης του σχεδιασμού καθώς και του
συνολικού κόστους με παράλληλη βελτίωση των επιδόσεων της μελέτης.

Σε ορισμένες περιπτώσεις, το αποτέλεσμα από μια τοπολογική βελ-
τιστοποίηση, μπορεί να είναι ακριβό ή ανέφικτο πρός κατασκευή. Το
γεγονός αυτό μπορεί να ξεπεραστεί με τη χρήση περιορισμών παραγω-
γής στη μοντελοποίηση του προβλήματος βελτιστοποίησης. Με την χρήση
των περιορισμών παραγωγής κατά την τοπολογική βελτιστοποίηση εξά-
γονται μοντέλα που ικανοποιούν τις απαιτήσεις της παραγωγή.

Εκτός απο τα προβλήματα βελτιστοποίησης της τοπολογίας έχουν
αναπτυχθεί διάφορες μορφές του γενικότερου προβλήματος εύρεσης της
βέλτιστης δομής μιας κατασκευής ή μηχανικού συστήματος, όπως τα
προβλήματα βελτιστοποίησης σχήματος και μεγέθους. Ένα τυπικό πρό-
βλημα βελτιστοποίησης μεγέθους θα μπορούσε να είναι το πάχος των
δοκών ενός δικτυώματος ή η κατανομή του πάχους σε μια δοκό. Το κύ-
ριο χαρακτηριστικό ενός προβλήματος μεγέθους ή διαστάσεων είναι ότι
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(αʹ) Βελτιστοποίηση μεγέθους.

(βʹ) Βελτιστοποίηση σχήματος.

(γʹ) Βελτιστοποίηση τοπολογίας.

Εικόνα 2.1: Κατηγορίες βελτιστοποίησης δομής.

η δομή της κατασκευής και οι παράμετροι ι καταστάσεως είναι γνωστές
a priori και σταθερές κατά την διάρκεια της βελτιστοποίησης. Από την
άλλη πλευρά, σε ένα πρόβλημα βελτιστοποίησης σχήματος σκοπός είναι η
εύρεση του βέλτιστου σχήματος της δομής, και έτσι για το πρόβλημα βελ-
τιστοποίησης σχήματος οι παράμετροι σχεδιασμού είναι η ίδια η δομή.
Στην Εικόνα 2.1 παρουσιάζονται οι τρείς κατηγορίες βελτιστοποίησης
της δομής τριών διαφορετικών κατασκευών.

• Βελτιστοποίηση μεγέθους: Στην Εικόνα 2.1(α') αριστερά παρου-
σιάζεται η δομή της κατασκευής πρίν την εφαρμογή της βελτιστο-
ποίησης μεγέθους της. Η δομή αποτελείται από δοκούς σε συγκε-
κριμένες θέσεις και ζητείται να βρεθεί το βέλτιστο πάχος των δο-
κών ώστε η κατασκευή να εντέχει τις φορτίσεις. Δεξιά της εικόνας
παρουσιάζεται το βελτιστοποιημένο σχήμα σε αντιδιαστολή με το
αρχικό. Έτσι, στο βέλτιστο σχήμα επιλέγονται πιο παχιές δοκοί και
σε συγκεκριμένη διάταξη.

• Βελτιστοποίηση σχήματος: Στην Εικόνα 2.1(β') παρουσιάζεται το
αρχικό χωρίο σχεδιασμού με έξι οπές. Σκοπός είναι να βρεθεί το
βέλτιστο σχήμα των οπών ώστε η κατασκευή να αντέξει τις φορτί-
σεις. Δεξιά της εικόνα παρουσιάζεται η τελική μορφή των οπών.

• Βελτιστοποίηση τοπολογίας: Στην Εικόνα 2.1(γ') παρουσιάζεται το
χωρίο σχεδιασμού χωρίς οπές, χωρίς προδιαγεγραμμένες θέσεις δο-
κών, και ζητείται ποια θα είναι η μορφή του χωρίου ώστε η κατα-
σκευή να αντέξει τις φορτίσεις. Δεξιά της εικόνα παρουσιάζεται η
βέλτιστη κατανομή του υλικού που ικανοποιεί τα κριτήρια σχεδια-
σμού.
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2.2 Μοντελοποίηση προβλήματος
O σκοπός της τοπολογικής βελτιστοποίησης είναι η εύρεση της βέλ-

τιστης κατανομής υλικού στο υπό μελέτη χωρίο. Οι μόνες γνωστές πα-
ράμετροι του προβλήματος είναι οι φορτίσεις, οι πιθανές στηρίξεις, ο
όγκος της κατασκευής, καθώς και επιπλέον περιορισμοί όπως η θέση
και το σχήμα περιοχών με απουσία (οπές) ή παρουσία υλικού. Σε αυτό
το πρόβλημα οι διαστάσεις, το σχήμα και η συνδεσμολογία (connectivity)
είναι τα ζητούμενα. Η τοπολογία, το σχήμα και οι διαστάσεις της κατα-
σκευής δεν αναπαρίστανται από συγκεκριμένες παραμετρικές συναρτή-
σεις, αλλά από ένα σύνολο κουκίδων (pixels), ενώ οι στόχοι σχεδιασμού
προσομοιώνονται με διάφορες μαθηματικές συναρτήσεις.

Εικόνα 2.2: Αρχικό χωρίο σχεδιασμού Ω.

2.3 Σχεδιασμός με ελαχιστοποίηση της ευκαμψίας
Στην συνέχεια θα περιγραφεί η μόρφωση του προβλήματος στο συνε-

χές μέσο. Ας υποθέσουμε ότι ένα ελαστικό σώμα καταλαμβάνει ένα χώρο
Ω𝑚𝑎𝑡 και είναι μέρος ενός ευρύτερου χωρίου αναφοράς Ω που ανήκει
στον δισδιάστατο ℝ􏷡 ή στον τρισδιάστατο χώρο ℝ􏷢. Το χωρίο αναφοράς
Ω έχει επιλεχθεί έτσι ώστε να είναι δυνατός ο ορισμός των φορτίσεων
και των συνοριακών συνθηκών. Το πρόβλημα ορίζεται ως η εύρεση της
βέλτιστης κατανομής υλικού έτσι ώστε το ολικό μέτρο δυσκαμψίας στο
χωρίο ορισμού Ω, ή πιο απλά στον ορισμό του χωρίου Ω𝑚𝑎𝑡 μέσα στα
όρια του Ω , ούτως ώστε να ελαχιστοποιείται η συνολική ευκαμψία και
να ικανοποιούνται οι συνθήκες ισορροπίας. Το συγκεκριμένο πρόβλημα
είναι ισοδύναμο με την μεγιστοποίηση της δυσκαμψίας της κατασκευής.
Μπορούμε, επίσης, να ορίσουμε το πρόβλημα ώς ένα πρόβλημα εύρεσης
του βέλτιστου τανυστή ακαμψίας 𝐸𝑖𝑗𝑘𝑙(𝑥) ο οποίος μεταβάλλεται κατά μή-
κος του χωρίου. H ενέργεια σε διγραμμική μορφή δίδεται από τη σχέση



2.4. ΠΑΡΑΜΕΤΡΟΠΟΙΗΣΗ ΣΧΕΔΙΑΣΜΟΥ 15

𝑎(𝑢, 𝑣) = 􏾙
􏸵

𝐸𝑖𝑗𝑘𝑙(𝑥)𝜀𝑖𝑗(𝑢)𝜀𝑘𝑙(𝑣)𝑑Ω (2.1)

όπου 𝜀𝑖𝑗(𝑢) = 􏷠
􏷡􏿴

𝜕𝑢𝑖
𝜕𝑥𝑗
+ 𝜕𝑢𝑗
𝜕𝑥𝑖
􏿷 η γραμμική έκφραση του τανυστή παραμόρφω-

σης από τον Νόμο του Hooke και 𝑙(𝑢) = ∫
􏸵
𝑓𝑢𝑑Ω + ∫

􏸶􏹿
𝑡𝑢𝑑𝑠, oι φορτίσεις

σε γραμμική μορφή. Έτσι το πρόβλημα ελαχιστοποίσης της ευκαμψίας
παίρνει την παρακάτω μορφή

min
𝑢∈𝑈,𝐸

𝑙(𝑢)

υ.π.
𝛼􏹖(𝑢, 𝑣) = 𝑙(𝑣), για όλα τα 𝑢 ∈ 𝑈,
𝐸 ∈ 𝐸𝑎𝑑.

(2.2)

όπου 𝑈 ορίζεται ο χώρος του κινηματικά αποδεκτού πεδίου μετατο-
πίσεων, 𝑓 ορίζεται το σύνολο των φορτίσεων που υπόκειται το σώμα και
𝑡 οι οριακές συνθήκες στο σύνορο Γ􏹥 ⊂ Γ ≡ 𝜕Ω. Στο πρόβλημα (3.2) το
𝐸𝑎𝑑 ορίζει το σύνολο των επιτρεπτών τανυστών παραμόρφωσης. Για ένα
πρόβλημα τοπολογική βελτιστοποίησης, το 𝐸𝑎𝑑 θα μπορούσε να είναι το
σύνολο των τανυστών ακαμψίας που εμπεριέχουν την πληροφορία των
ιδιοτήτων του δοθέντος ισοτροπικού υλικού στο χωρίο Ω𝑚𝑎𝑡, δηλαδή στο
χωρίο που εμπεριέχεται υλικού, με τον περιορισμό ∫

􏸵
1𝑑Ω ≤ 𝑉 .

2.4 Παραμετροποίηση σχεδιασμού
Όπως σημειώθηκε και σε προηγούμενη ενότητα στόχος της τοπολογι-

κής βελτιστοποίησης είναι η εύρεση της βέλτιστης κατανομής υλικό στο
σχεδιαστικό χώρο Ω, δηλαδή ο καθορισμός των σημείων που θα έχουν
υλικό Ω𝑚𝑎𝑡 και αυτά που θα είναι κενά (χωρίς υλικό), Ω𝑣𝑜𝑖𝑑 = Ω − Ω𝑚𝑎𝑡.
Η γεωμετρική αναπαράσταση είναι όμοια με αυτήν μιας εικόνας, όπου
με μαύρο θα αναπαρίστανται οι περιοχές που περιέχουν υλικό και με
λευκό οι περιοχές που δεν περιέχουν. Η γραφική αναπαράσταση η οποία
αποτελείται από 'pixels' τα οποία αναπαριστούν στην περίπτωσή μας τα
πεπερασμένα στοιχεία του. Για κάθε στοιχείο 𝑒 μπορεί να θεωρηθεί μια
πυκνότητα 𝜌𝑒:

𝜌𝑒 = 􏿼
𝜌􏷟 , άν e ∈ Ω𝑚𝑎𝑡
0 , άν e ∈ Ω𝑣𝑜𝑖𝑑

(2.3)

όπου 𝜌􏷟 είναι η πυκνότητα του στοιχείου του υλικού όταν υπάρχει
υλικό. Ορίζεται η σχετική πυκνότητα 𝑥𝑒 ώς το πηλίκο της πυκνότητας
του στοιχείου 𝑒, προς 𝜌𝑜, δηλαδή:
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𝑥𝑒 =
𝜌𝑒
𝜌􏷟
, 𝑒 = 1,… ,𝑁 (2.4)

Επομένως, περιορίζοντας το χωρίο Ω, επιδιώκουμε να καθορίσουμε το
βέλτιστο υποσύνολο Ω𝑚𝑎𝑡 των σημείων που έχουν υλικό. Στο πρόβλημα
τοπολογικής βελτιστοποίησης που ορίζεται παραπάνω το σύνολο 𝐸𝑎𝑑 των
επιτρεπτών τανυστών ακαμψίας για τους οποίους ισχύει ότι

𝐸𝑖𝑗𝑘𝑙 = 1􏸵𝑚𝑎𝑡𝐸􏷟𝑖𝑗𝑘𝑙 (2.5)

όπου
1􏸵𝑚𝑎𝑡 = 􏿼

1 , άν x∈ Ω𝑚𝑎𝑡
0 , άν x∈Ω⧵Ω𝑚𝑎𝑡

(2.6)

􏾙
􏸵

1􏸵𝑚𝑎𝑡𝑑Ω = 𝑉𝑜𝑙(Ω𝑚𝑎𝑡) ≤ 𝑉 (2.7)

Η τελευταία ανισότητα εκφράζει ένα όριο V, στην ποσότητα υλικού
που επιδέχεται μεταβολή, έτσι ώστε η ελαχιστοποίηση της ευκαμψίας
απευθύνεται σε ένα μειωμένο (ορισμένο) όγκο. Ο τανυστής 𝐸􏷟𝑖𝑗𝑘𝑙 είναι ο
τανυστής ακαμψίας όπου 𝐸𝑖𝑗𝑘𝑙 ∈ 𝐿∞(Ω). Με τον ορισμό αυτό για το 𝐸𝑎𝑑
το πρόβλημα τοπολογικής βελτιστοποίησης μετατρέπεται σε πρόβλημα
ακέραιου προγραμματισμού 0-1.

Η πιο συχνή στρατηγική που χρησιμοποιείται για την επίλυση προ-
βλημάτων ακέραιου προγραμματισμού είναι η αντικατάσταση των ακέ-
ραιων μεταβλητών από συνεχείς μεταβλητές μέσα σε ένα διάστημα, ει-
σάγοντας παράλληλα και ένα είδος ποινής ώστε οι συνεχείς μεταβλητές
να οδηγούνται στα όρια ορισμού τους. Έτσι το πρόβλημα σχεδιασμού για
το δεδομένο χωρίο μετατρέπεται σε πρόβλημα διαστασιολόγησης μετα-
βάλλοντας τον πίνακα δυσκαμψίας ώστε να εξαρτάται από μια συνεχή
συνάρτηση που εκφράζει την σχετική πυκνότητα του υλικού. Η συνάρ-
τηση αυτή είναι η νέα μεταβλητή σχεδιασμού. Η μόνη απαίτηση για την
συνάρτηση αυτή είναι, οι τιμές της να δηλώνουν παρουσία ή απουσία
υλικού. Μια τέτοια στρατηγική η οποία έχει αποδειχθεί εξαιρετικά επι-
τυχής είναι το μοντέλο ανάλογης δυσκαμψίας ισότροπου υλικού με ποινή
ή αλλιώς SIMP (Solid Isotropic Material with Penalization)[9].

𝐸𝑖𝑗𝑘𝑙(𝑥) = 𝜌(𝑥)𝑝𝐸􏷟𝑖𝑗𝑘𝑙, 𝑝 > 1, (2.8)

􏾙
􏸵

𝜌(𝑥)𝑑Ω ≤ 𝑉, 0 ≤ 𝜌(𝑥) ≤ 1, 𝑥 ∈ Ω (2.9)
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όπου η 𝜌(𝑥) είναι η συνάρτηση πυκνότητας και το 𝐸􏷟𝑖𝑗𝑘𝑙 αντιπροσω-
πεύει τις ιδιότητες του δοθέντος ισοτροπικού υλικού. Έτσι, η ποσότητα
∫
􏸵
𝜌(𝑥)𝑑Ω ορίζει τον όγκο της κατασκευής.

𝐸𝑖𝑗𝑘𝑙(𝜌 = 0) = 0, 𝐸𝑖𝑗𝑘𝑙(𝜌 = 1) = 𝐸􏷟𝑖𝑗𝑘𝑙 (2.10)
Eπομένως, άν το τελικό σχέδιο έχει πυκνότητα μηδέν ή ένα σε όλα τα

σημεία αποτελεί ένα ασπρό-μαυρο σχεδιασμό που μπορεί να αποτελέσει
ένα φυσικό μοντέλο. Στη μέθοδο SIMP επιλέγεται ώς ποινή 𝑝 > 1, ώστε
οι ενδιάμεσες πυκνότητες να είναι ανεπιθύμητες και να μην λαμβάνο-
νται υπόψη στον καθορισμό του τελικού μοντέλου. Για προβλήματα που
ο περιορισμός του όγκου είναι ενεργός, η εμπειρία έδειξε ότι η τοπολο-
γική βελτιστοποίηση έχει αποτελέσματα άν ο συντελεστής ποινής 𝑝 είναι
αρκετά μεγάλος και στις περισσότερες περιπτώσεις παίρνει τιμές 𝑝 ≥ 3.

Eπομένως, το πρόβλημα ελαχιστοποίησης της ευκαμψίας όπως δια-
μορφώνεται στο ABAQUS/CAE [10] έχει ώς εξής:

min
𝜌
𝑢𝑜𝑢𝑡

υ.π.
𝑛
􏾜
𝑒=􏷠

𝑣𝑒𝜌𝑒 ≤ 𝑉, 0 ≤ 𝜌𝑒 ≤ 1,

(2.11)

Εικόνα 2.3: Σχηματική παρουσίαση αλγορίθμου.

2.5 Περιπτωση πολλαπλών φορτίσεων
Το πρόβλημα ελαχιστοποίησης της ευκαμψίας μιας κατασκευής όταν

αυτή υπόκεινται σε μια και μόνη φόρτιση μπορεί να γενικευτεί και για
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περισσότερες φορτίσεις. Θα πρέπει να διευκρινιστεί ότι, όταν γίνεται
αναφορά σε πολλαπλές φορτίσεις, οι φορτίσεις αυτές δεν επιβάλλονται
ταυτόχρονα, αλλά κάθε φορά. Αν στην κατασκευή εφαρμόζονται περισ-
σότερα από ένα φορτία ταυτόχρονα τότε οι φορτίσεις αυτές καθιστούν
μια περίπτωση φόρτισης. Όταν όμως η κατασκευή υπόκειται σε διαφο-
ρετικές φορτίσεις κάθε φορά τότε έχουμε ένα πρόβλημα τοπολογικής
βελτιστοποίησης πολλαπλών φορτίσεων. Στο συγκεκριμένο πρόβλημα
ζητείται η ελαχιστοποίηση της ευκαμψίας της κατασκευής για όλες τις
περιπτώσεις φορτίσεων:

⎧⎪⎪⎪⎪⎪
⎨⎪⎪⎪⎪⎪⎩

min
𝑢􏷪,𝑥𝑒

𝑐􏷠(𝑥𝑒) = 𝑓𝑇􏷠 𝑢􏷠,

min
𝑢􏷫,𝑥𝑒

𝑐􏷡(𝑥𝑒) = 𝑓𝑇􏷡 𝑢􏷡,

⋮
min
𝑢𝑚,𝑥𝑒

𝑐𝑚(𝑥𝑒) = 𝑓𝑇𝑚𝑢𝑚,

(2.12)

όπου 𝑚 είναι το σύνολο των διαφορετικών περιπτώσεων φόρτισης. Το
πρόβλημα είναι πολυκριτήριο αφού κάθε κριτήριο αποτελείται από την
ελαχιστοποίηση της ευκαμψίας για μία περίπτωση φόρτισης. Το πολυ-
κριτήριο πρόβλημα μπορεί να αντικατασταθεί από ένα και μόνο κριτήριο
που μπορεί να αποτελείται από το σταθμισμένο άθροισμα των ευκαμ-
ψιών [9]:

min
𝑚
􏾜
𝑖=􏷠
𝑤𝑖𝑐𝑖 =

𝑚
􏾜
𝑖=􏷠
𝑤𝑖𝑢𝑇𝑖 𝐾𝑢𝑖

υ.π.

􏿴
𝑁
􏾜
𝑒=􏷠

𝑥𝑝𝑒𝐾𝑜􏿷𝑢𝑖 = 𝑓𝑖, 𝑖 = 1, … ,𝑚

𝑁
􏾜
𝑒=􏷠

𝑣𝑒𝑥𝑒 ≤ 𝜑𝑉𝑜,

0 < 𝑥𝑚𝑖𝑛 ≤ 𝑥𝑒 ≤ 1, 𝑒 = 1,… ,𝑁
𝑚
􏾜
𝑖=􏷠
𝑤𝑖 = 1

(2.13)

όπου 𝑤𝑖 το βάρος για κάθε περίπτωση φόρτισης. Θα πρέπει το σύνολο
των βαρών να είναι ίσο με την μονάδα.
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2.6 Περιγραφή του αλγορίθμου

2.6.1 Υπολογιστική διαδικασία
Ο σχεδιασμός τοπολογίας με χρήση μεθόδων διανομής υλικού βασίζε-

ται στον αριθμητικό υπολογισμό της βέλτιστης διανομής της πυκνότητας
του υλικού 𝑥. Η μέθοδος που χρησιμοποιείται για την ποινικοποίηση των
ενδιάμεσων τιμών των μεταβλητών σχεδιασμού ώστε η διανομή του υλι-
κού να αποτελείται από στοιχεία με τιμές σχετικής πυκνότητας κοντά
στο 0 ή 1, είναι η μέθοδος SIMP. Η μέθοδος των βέλτιστων κριτηρίων για
την εύρεση της βέλτιστης τοπολογίας μιας κατασκευής που αποτελείται
από ένα (και μόνο) ισότροπο υλικό μπορεί να αναλυθεί στα παρακάτω
βήματα:

1. Ορισμός του αρχικού χωρίου σχεδιασμού.

2. Βελτιστοποίηση

3. Παρουσίαση αποτελεσμάτων

2.6.2 Ορισμός του αρχικού χωρίου σχεδιασμού
Στο στάδιο αυτό ορίζεται το αρχικό χωρίο σχεδιασμού Ω:

• ορίζονται τα όρια του χωρίου σχεδιασμού, καθώς και οι διάφορες
στηρίξεις, κυλήσεις, δυνάμεις

• ορίζονται εκείνες οι περιοχές του αρχικού χωρίου, όπου αναγκα-
στικά θα πρέπει να υπάρχει ή όχι υλικό,

• ορίζεται το πλέγμα των πεπερασμένων στοιχείων για το χωρίο σχε-
διασμού. Το πλέγμα θα πρέπει να είναι αρκετά πυκνό ώστε η κα-
τασκευή να μπορεί να αναπαρασταθεί ικανοποιητικά με στοιχεία
0-1, ικανοποιητικής ανάλυσης. Θα πρέπει επίσης να είναι δυνατός
εκ των προτέρων ο ορισμός εκείνων των περιοχών της κατασκευής
όπου οι μεταβλητές σχεδιασμού έχουν σταθερή τιμή (παρουσία ή
απουσία υλικού). Το πλέγμα θα πρέπει να παραμένει σταθερό καθ’
όλη την διάρκεια της βελτιστοποίησης

• ορίζονται τα πεδία των μετακινήσεων και των μεταβλητών σχεδια-
σμού ώστε να είναι δυνατή η μετεπεξεργασία των αποτελεσμάτων.

2.6.3 Βελτιστοποίηση
Στο στάδιο αυτό λαμβάνει χώρα ο υπολογισμός της βέλτιστης διανο-

μής υλικού πάνω στο χωρίο αναφοράς για τις μεταβλητές σχεδιασμού �.
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Η διαδικασία της βελτιστοποίησης βασίζεται στην ανάλυση πεπερασμέ-
νων στοιχείων και στο σχήμα ανανέωσης των μεταβλητών σχεδιασμού
με την χρήση κριτηρίων βελτιστοποίησης. Η δομή του αλγόριθμου είναι
η παρακάτω:

1. Βήμα 1. Γίνεται αρχικοποίηση των μεταβλητών σχεδιασμού με ομοιό-
μορφη κατανομή υλικού σε όλο το χωρίο σχεδιασμού, εκτός των
περιοχών που έχουν οριστεί εκ των προτέρων ως περιοχές με υπο-
χρεωτική παρουσία ή απουσία υλικού.

2. Βήμα 2. Έναρξη των επαναλήψεων. Για την συγκεκριμένη κατα-
νομή υλικού, γίνεται επίλυση του περιορισμού ισορροπίας με πε-
περασμένα στοιχεία, και υπολογίζονται οι μετακινήσεις και οι πα-
ραμορφώσεις

3. Βήμα 3. Γίνεται υπολογισμός της ευκαμψίας της κατασκευής. Εάν
δεν υπάρχει βελτίωση (μέσα σε κάποιο διάστημα) σε σχέση με την
προηγούμενη επανάληψη τότε γίνεται διακοπή της επαναληπτικής
διαδικασίας. Αλλιώς συνεχεία.

4. Βήμα 4. Υπολογισμός των τιμών των μεταβλητών σχεδιασμού. Στο
βήμα αυτό υπολογίζεται η τιμή του συντελεστή Lagrange 𝜆 για τον
περιορισμό του όγκου.

5. Βήμα 5. Επανάληψη του βήματος (2).

2.6.4 Παρουσίαση αποτελεσμάτων
Παρουσιάζεται η τελική κατανομή του υλικού η οποία καθορίζει την

βέλτιστη τοπολογία της κατασκευής.

Εικόνα 2.4: Διάγραμμα ροής αλγορίθμου.



Κεφάλαιο 3

Μοντελοποίηση στο
Pro/ENGINEER

3.1 Εισαγωγή
Το Pro/ENGINEER δημιουργήθηκε από την Parametric Technology

Corporations (PTC) ήταν η πρώτη εταιρεία στην αγορά που αξιοποί-
ησε τον παραμετρικό σχεδιασμό. H έκδοση που χρησιμοποιήθηκε στην
παρούσα εργασία είναι η Wildfire 5 για τη μοντελοποίηση του αρχικού
μοντέλου, η οποία και κυκλοφόρησε για πρώτη φορά το 2001. Η χρήση
του προγράμματος αυτού, παρέχει στερεά μοντελοποίηση, μοντελοποί-
ηση συναρμολόγησης και ανάλυση πεπερασμένων στοιχείων. Δημιουργή-
θηκε από τον Δρ Samuel P. Geisberg στα μέσα της δεκαετίας του 1980,
το Pro/ENGINEER ήταν η πρώτη επιτυχία του κλάδου του παραμετρι-
κού σχεδιασμό. Η παραμετρική μοντελοποίηση είναι προσέγγιση που
χρησιμοποιεί παραμέτρους τις διαστάσεις, τα χαρακτηριστικά και τις
μαθηματικές σχέσεις για να συλλάβει τη συμπεριφορά των προϊόντων
που προορίζεται και να δημιουργήσει ένα μέσο που επιτρέπει την αυ-
τοματοποίηση του σχεδιασμού, τη βελτιστοποίηση του σχεδιασμού και
των διαδικασιών ανάπτυξης των προϊόντων. Το Pro/ENGINEER παρέχει
ένα πλήρες σύνολο του σχεδιασμού, της ανάλυσης και των δυνατοτήτων
κατασκευής σε μία ενσωματωμένη, επεκτάσιμη πλατφόρμα. Οι απαιτού-
μενες ικανότητες περιλαμβάνουν στερεά και επιφανειακή μοντελοποί-
ηση (Solid-Surface Modeling), δημιουργώντας δεδομένα διαλειτουργικά,
τα οποία αξιοποιούνται για τον σχεδιασμό συστημάτων, προσομοίωση,
ανάλυση αντοχής, καθώς και σχεδιασμό εργαλείων. Οι εταιρείες χρησιμο-
ποιούν το Pro/ENGINEER για να δημιουργήσουν ένα πλήρες 3D ψηφιακό
μοντέλο των προϊόντων τους. Τα μοντέλα αποτελούνται από 2D και 3D
στερεά μοντέλα δεδομένων τα οποία μπορούν να χρησιμοποιηθούν και
σε ανάλυση πεπερασμένων στοιχείων, ταχεία προτυποποίηση, σχεδιασμό
εργαλείων και CNC κατασκευών.

21



3.2. ΔΗΜΙΟΥΡΓΙΑ ΕΠΙΠΕΔΟΥ 22

3.2 Δημιουργία επιπέδου
Ξεκινάμε το Pro/ENGINEER από Start → Programs → PTC→ Pro/

ENGINEER →Pro/ENGINEER. Το αρχικό παράθυρο εμφανίζεται. Από
την καρτέλα File επιλέγουμε Set Working Directory και ορίζουμε τον
φάκελο στον οποίο θέλουμε να γίνονται όλες οι αποθηκεύσεις αρχείων,
διαφορετικά το Pro/ ENGINEER χρησιμοποιεί προεπιλεγμένες θέσεις για
αποθήκευση που είχαν οριστεί κατά την εγκατάστασή του.

Αφού εμφανιστεί το βασικό παράθυρο του Pro/ENGINEER, είμαστε
έτοιμοι να αρχίσουμε τη σχεδίαση του εξαρτήματος. Το εξάρτημα το
οποίο θα σχεδιάσουμε αποτελεί τον ρότορα μιας ανεμογεννήτριας και
φαίνεται στην παρακάτω Εικόνα .

Εικόνα 3.1: Τελικό μοντέλο ρότορα ανεμογεννήτριας

Από την καρτέλα File επιλέγουμε New για να εμφανιστεί το παρά-
θυρο δημιουργίας ενός νέου εγγράφου. Στο Wildfire 5 έχουμε τη δυνατό-
τητα να δημιουργήσουμε διάφορα είδη αρχείων με τα πιο σημαντικά Part,
Assembly, Drawing με καταλήξεις .prt, .asm, .drw αντίστοιχα. Το .prt
αποτελεί τον τύπο αρχείου ενός στερεού εξαρτήματος, ενώ το .asm ενός
μοντέλου συναρμολόγησης. Το συγκεκριμένο αρχείο μπορεί να ανοίξει
με την προυπόθεση ότι βρίσκονται όλα τα αρχεία .prt, των εξαρτημάτων
που το αποτελούν στον ίδιο φάκελο με το .asm (Assembly). Το αρχείο
Drawing έχει κατάληξη .drw και είναι το αρχείο ενός μηχανολογικού σχε-
δίου που περιγράφει όλες τις διαστάσεις ενός εξαρτήματος ή/και ενός
συναρμολογήματος. Ομοίως, το συγκεκριμένο αρχείο μπορεί να ανοίξει
με την προυπόθεση ότι βρίσκονται όλα τα αρχεία .prt των εξαρτημάτων
που το αποτελούν ή το .asm(Assembly) στον ίδιο φάκελο με το .drw
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(Drawing). Για τη σχεδίαση του εξαρτήματός μας επιλέγουμε Part και
ώς Sub-type, Solid. Επιλέγουμε το όνομα του αρχείου και πατώντας ΟΚ
εισερχόμαστε στον τρισδιάστατο χώρο εργασίας. Πλέον, είμαστε έτοιμοι
να αρχίσουμε τη σχεδίαση του μοντέλου. Στα αριστερά υπάρχει το δέ-
ντρο χαρακτηριστικών (Model Tree) στο οποίο και αναγράφονται όλα τα
μορφολογικά χαρακτηριστικά που χρησιμοποιήθηκαν για τη δημιουργία
του μοντέλου. Στην αρχή, το Wildfire 5 εισάγει αυτόματα επτά χαρα-
κτηριστικά, τα οποία είναι τα τρία επίπεδα στο χώρο (Datum Planes),
το σύστημα συντεταγμένων αναφοράς και οι τρείς άξονες που περνούν
απο το (0,0). Για τις ανάγκες σχεδίασης του ρότορα δημιουργήσαμε ένα
καινούργιο επίπεδο στο χώρο (Datum Plane) πάνω στο οποίο θα σχε-
διάσουμε τη διάμετρο του βασικού κελύφους του ρότορα. Επιλέγουμε
από την καρτέλα Insert → Model Datum → Plane ή εναλλακτικά από τα
εργαλεία που εμφανίζονται στα δεξιά του χώρου σχεδίασης, το εικονίδιο

(Datum Plane).
Το παράθυρο Datum Plane εμφανίζεται. Κάτω από την καρτέλα Place-

ment επιλέγουμε ως αναφορά (Reference) το επίπεδο στο οποίο θέλουμε
να είναι παράλληλο το καινούργιο που θα δημιουργηθεί, ορίζονας ταυτό-
χρονα την απόσταση μεταξύ τους στο Offset. Εναλλακτικά, επιλέγοντας
την άσπρη κουκίδα που εμφανίζεται στην Εικόνα 3.2, μας δίδεται η
δυνατότητα να ορίσουμε χειροκίνητα την απόσταση των δύο επιπέδων,
κουνώντας το επίπεδο με την κίνηση του ποντικιού. Επιβεβαιώνουμε την
επιλογή με OK.

Εικόνα 3.2: Παράθυρο καθορισμού του DTM1.

3.3 Μοντελοποίηση βασικής διαμέτρου.
Για τη μοντελοποίηση της βασικής διαμέτρου είναι αναγκαία η υλο-

ποίηση μίας διατομής η οποία στη συνέχεια θα προεκταθεί ορίζοντας
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το ύψος του ρότορα. Για σχεδίαση της διατομής αυτής (Sketch1) επιλέ-
γουμε από την καρτέλα Insert → Model Datum → Sketch ή εναλλακτικά
το εικονίδιο (Sketch Tool) από την μπάρα εργαλειών. Με αυτόν τον
τρόπο επιλέγουμε να σχεδιάσουμε μια δισδιάστατη διατομή, την οποία
στη συνέχεια θα προεκτείνουμε.

Εικόνα 3.4: Δημιουργία διατομής 1 στο Sketcher.

Εικόνα 3.3: Παράθυρο προσανατολι-
σμού του Sketcher.

Εμφανίζεται το παράθυρο Sketch
(βλ. Εικόνα 3.3) μέσα από το
οποίο θα ορίσουμε τον προσανα-
τολισμό του Sketch. Επιλέγουμε
το επίπεδο XY ώς Sketch Plane
με αριστερό click από το Model
Tree ή εναλλακτικά από τον τρισ-
διάστατο χώρο, παρατηρώντας ότι
χρωματίζεται κόκκινο εφόσον επι-
λεγεί. Ώς Reference επιλέγουμε το
YZ Plane και ώς Orientation το
Bottom, που καθορίζουν τον προ-
σανατολισμό με τον οποίο θα βλέ-
πουμε αυτό που σχεδιάζουμε.

Επιλέγοντας το εικονίδιο
μεταφερόμαστε σε ένα διαφορετικό παράθυρο που ονομάζεται Sketcher.
Ουσιαστικά έχουμε μεταφερθεί κάθετα και πάνω από το επίπεδο στο
οποίο θέλουμε να σχεδιάσουμε. Το Sketcher έχει τα δικά του εργαλεία
για τη σχεδίαση διατομών, ευθύγραμμων τμημάτων, ελλείψεων, κύκλων,
κυκλικών τόξων κτλ. Επιλέγουμε στο παράθυρο των References
που εμφανίζεται, καθώς δεν είναι απαραίτητη κάποια αναφορά για την
τοποθέτηση της διατομής στο χώρο.

Ο οριζόντιος και ο κατακόρυφος άξονας που φαίνονται στο Sketcher
είναι τα επίπεδα XZ και YZ Plane, αλλά αφού αυτά είναι κάθετα στο
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XY Plane φαίνονται ώς ευθύγραμμα τμήματα. Επιλέγουμε το εικονίδιο
(Create Circle) και με αριστερό click στην τομή των ευθειών ορί-

ζουμε το κέντρο του κύκλου. Μετακινώντας το ποντίκι παρατηρούμε
ότι αυξομειώνεται η διάμετρος του κύκλου, έτσι κάνοντας ένα δεύτερο
αριστερό click δημιουργείται ένας κύκλος με τυχαία ακτίνα. Πατώντας

Εικόνα 3.5: Δημιουργία Sketch 1.

το εικονίδιο (Select Item) ή εναλλακτικά μεσαίο click με το ποντίκι
αποεπιλέγουμε το εργαλείο Create Circle. Kάνοντας διπλό click στις δια-
στάσεις μπορούμε να ορίσουμε την τιμή της διαμέτρου. Εφαρμόζουμε
μεσαίο click με το ποντίκι ή Enter για να επιβεβαιώσουμε την επιλογή
μας. Μόλις βάλουμε τις σωστές διαστάσεις πατάμε το εικονίδιο για
να επικυρώσουμε τη σχεδίαση της διατομής. Το Wildfire 5 μας επαναφέ-
ρει στον τρισδιάστατο χώρο και μπορούμε πλέον να δούμε τη διατομή
που σχεδιάσαμε, παρατηρώντας ότι το Sketch1 έχει αναγραφεί στο Model
Tree. Κρατώντας πατημένο το μεσαίο πλήκτρο του ποντικιού μπορούμε
να περιστρέψουμε το μοντέλο και να το επιβλέψουμε.

3.4 Μοντελοποίηση βασικής αξονοσυμμετρικής γεω-
μετρίας.

Στη συνέχεια, επαναλαμβάνουμε την ίδια διαδικασία για τη μοντε-
λοποίηση βασικής αξονοσυμμετρικής γεωμετρίας, με τη δημιουργία της
διατομής 2 (Sketch 2). Έτσι, επιλέγουμε πάλι το εικονίδιο και στο
παράθυρο που εμφανίζεται επιλέγουμε ώς Sketch Plane το Datum Plane
1 (DTM1) που δημιουργήσαμε στην αρχή. Ώς Reference επιλέγουμε το
YZ Plane και ώς Orientation το Right (βλ. Εικόνα 3.7). Πατάμε Close στο
παράθυρο των References. Από την μπάρα εργαλειών του Sketcher επι-



3.4. ΜΟΝΤΕΛΟΠΟΙΗΣΗ ΒΑΣΙΚΗΣ ΑΞΟΝΟΣΥΜΜΕΤΡΙΚΗΣ
ΓΕΩΜΕΤΡΙΑΣ. 26

Εικόνα 3.6: Δημιουργία διατομής 2 στο Sketcher .

λέγουμε το εικονίδιο (Create Circle) και με αριστερό click στο σημείο
αυτό ορίζουμε το κέντρο του κύκλου. Με ένα δεύτερο αριστερό click δη-
μιουργείται ένας κύκλος με τυχαία ακτίνα. Πατώντας το εικονίδιο (Select
Item)

Εικόνα 3.7: Παράθυρο προσανατολι-
σμού του Sketcher.

ή εναλλακτικά μεσαίο click και
κάνοντας διπλό click στις διαστά-
σεις μπορούμε να ορίσουμε την
τιμή της διαμέτρου. Με μεσαίο
click ή Enter επιβεβαιώνουμε την
επιλογή μας. Στη συνέχεια, επι-
λέγουμε το εικονίδιο για να
σχεδιάσουμε τα ευθύγραμμα τμή-
ματα που σχηματίζουν το ισό-
πλευρο τρίγωνο της Εικόνας 3.6.
Πατώντας το εικονίδιο (Select
Item) και κάνοντας διπλό click στη
διαστάση της γωνίας μπορούμε να
ορίσουμε την τιμή της. Πατάμε
το εικονίδιο για να επικυρώ-
σουμε τη σχεδίαση της διατομής.
Η συγκεκριμένη διατομή λειτουργεί ώς βοηθητική για την ανάπτυξη της
γεωμετρίας του ρότορα όπως θα φανεί παρακάτω. Το Wildfire 5 μας
επαναφέρει στον τρισδιάστατο χώρο και μπορούμε πλέον να δούμε τη
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διατομή που σχεδιάσαμε, παρατηρώντας επίσης ότι το Sketch 2 έχει ανα-
γραφεί στο Model Tree.

3.5 Μοντελοποίηση τρισδιάστατου σώματος ρότορα.

Εικόνα 3.8: Προεπισκόπηση
Extrude.

Στη συνέχεια, θα προεκτεί-
νουμε τη διατομή της βασικής δια-
μέτρου του ρότορα (Sketch 1) με
την εντολή Extrude, για να δη-
μιουργήσουμε ένα τρισδιάστατο,
συμπαγές στερεό. Επιλέγουμε τη
διατομή Sketch 1 είτε από το
Model Tree είτε απο τον τρισδιά-
στατο χώρο, ώστε να γίνει κόκ-
κινη. Έπειτα, επιλέγουμε από την
καρτέλα Insert → Extrude ή εναλ-
λακτικά το εικονίδιο (Extrude
Tool). Όπως φαίνεται στο χώρο
εργασίας διατίθεται μία προεπι-
σκόπηση του στερεού που θα δη-
μιουργηθεί. Από το παράθυρο καθορισμού του Extrude μπορούμε να
καθορίσουμε την κατεύθυνση που πρόκειται να προεκταθεί καθώς και
να την αλλάξουμε πατώντας το εικονίδιο . Αρκεί να παρατηρήσουμε
το κίτρινο βέλος στον τρισδιάστατο χώρο για να γνωρίζουμε την κατεύ-
θυνση προς την οποία πρόκειται να υλοποιηθεί το Extrude. Επιλέγουμε
το βάθος του Extrude με το εικονίδιο . Εναλλακτικά επιλέγοντας
την άσπρη κουκίδα κατά την προεπισκόπηση (βλ. Εικόνα 3.8), έχουμε
τη δυνατότητα να ορίσουμε χειροκίνητα το βάθος. Ολοκληρώνουμε το
Extrude1 με το εικονίδιο . Στη συνέχεια, επιλέγουμε από την καρ-
τέλα Insert → Draft ή εναλλακτικά το εικονίδιο (Draft Tool).

Από το παράθυρο καθορισμού του Draft (βλ. Εικόνα 3.9) μπορούμε
να καθορίσουμε την επιφάνεια στην οποία θα εφαρμοστεί. Την επιλέ-
γουμε με αριστερό click από τον τρισδιάστατο χώρο και εάν γίνει κόκ-
κινη έχει επιλεγεί. Λεπτομέρειες για τον προσανατολισμό του Draft κα-
θορίζονται στην καρτέλα References. Επίσης, μπορούμε να ορίσουμε την
γωνία κλίσης του Draft είτε πληκτρολογώντας την τιμή της δίπλα στο
εικονίδιο , είτε επιλέγοντας την άσπρη κουκίδα ορίζοντας την έτσι
χειροκίνητα με την κίνηση του ποντικιού. Τέλος, έχουμε τη δυνατότητα
να αλλάξουμε την κατεύθυνση του Draft πατώντας το εικονίδιο . Για
να γνωρίζουμε την κατεύθυνση προς την οποία πρόκειται να υλοποιηθεί
το Draft, αρκεί να παρατηρήσουμε το κίτρινο βέλος στον τρισδιάστατο
χώρο. Ολοκληρώνουμε το Draft με το εικονίδιο .
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Εικόνα 3.9: Παράθυρο καθορισμού του Draft.

3.6 Μοντελοποίηση βάσης έδρασης πτέρυγας.
Για τον σχεδιασμό των βάσεων έδρασης των τριών πτερυγίων πλευ-

ρικά του βασικού τρισδιάστατου σώματος του ρότορα γίνεται χρήση της
εντολής Extrude. Έτσι, θεωρήθηκε αναγκαία η δημιουργία τριών Datum
Planes πάνω στα οποία έγινε η σχεδίαση των τριών διατομών Sketches τα
οποία στη συνέχεια θα προεκταθούν.

Εικόνα 3.10: Καμπύλες για τη δη-
μιουργία του PNT0

Κάθε επίπεδο στο χώρο ορίζε-
ται από ένα σημείο και έναν
άξονα. Έτσι, για τη δημιουρ-
γία των σημείων (Datum Points)
επιλέγουμε από την καρτέλα
Insert→Model Datum→Points ή
εναλλακτικά απο τα εργαλεία
(Datum Points).

Αρχικά, δημιουργούμε τα τρία
Datum Points στις κορυφές του
τριγώνου και για να τα ορίσουμε
θα χρειαστεί να επιλέξουμε δύο
καμπύλες στην τομή των οποίων
βρίσκεται το εκάστοτε σημείο.
Έτσι, για το πρώτο σημείο (PNT0)
επιλέγουμε τις καμπύλες που φαίνονται στην Εικόνα 3.10. Για να γίνει
η επιλογή των δύο καμπυλών επιλέγουμε την πρώτη και με ctrl πατη-
μένο επιλέγουμε τη δεύτερη. Πλέον και οι δύο καμπύλες είναι κόκκινες
άρα έχουν επιλεγεί. Ολοκληρώνουμε με ΟΚ. Ομοίως, δημιουργούμε τα
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επόμενα δύο σημεία PNT1και PNT2 όπως φαίνεται στην Εικόνα 3.11.
Στη συνέχεια, δημιουργούμε τους τρείς άξονες κάνοντας χρήση των

τριών Datum Points. Έτσι, επιλέγοντας από την καρτέλα Insert→ Model
Datum → Axis ή εναλλακτικά από τα εργαλεία το εικονίδιο (Datum
Axis), εμφανίζεται το παράθυρο Datum Axis. Κρατώντας πατημένο το
πλήκτρο Ctrl του πληκτρολογίου, επιλέγουμε το σημείο (Datum Point) και
το επίπεδο (Datum Plane) στο οποίο θέλουμε να είναι κάθετος ο άξονας.
Παρατηρούμε στην καρτέλα Placement ότι ο άξονας περνά από το σημείο
που δημιουργήσαμε στο προηγούμενο βήμα και είναι κάθετος (Normal)
στο XY Plane. Ομοίως, δημιουργούμε τους επόμενους δύο άξονες Α2 και
Α3 αντίστοιχα. Στην Εικόνα 3.13 παρατίθεται η διαδικασία ορισμού των
αξόνων (Datum Axis).

Εικόνα 3.12: Μετά την ολοκλήρωση
των αξόνων Datum Axis.

Παρατηρούμε ότι και στις
τρείς περιπτώσεις το επίπεδο κά-
θετο στους άξονες παραμένει το
ίδιο ενώ αλλάζουν τα σημεία, επο-
μένως οι τρείς άξονες που δη-
μιουργήθηκαν είναι με τη σειρά
τους μεταξύ τους παράλληλοι. Το
σχέδιο θα πρέπει να φαίνεται
όπως στην Εικόνα 3.12.

Στη συνέχεια από τους τρείς
άξονες ορίζουμε τα τρία επί-
πεδα. Επιλέγοντας από την καρ-
τέλα Insert → Model Datum →
Plane ή εναλλακτικά από τα ερ-
γαλεία το εικονίδιο (Datum
Plane) και εμφανίζεται το παράθυρο Datum Plane. Κρατώντας πατη-
μένο το πλήκτρο Ctrl επιλέγουμε το σημείο (Datum Point) και τον άξονα
(Datum Αxis) πάνω στον οποίο βρίσκεται το σημείο. Συγκεκριμένα, για
να ορίσουμε το επίπεδο DTM2 στην καρτέλα Placement επιλέγουμε τον
άξονα Α3 που περνά από το σημείο PNT3 (Through) και το επίπεδο
XΖ Plane το οποίο τίθεται παράλληλο (Parallel) σε αυτό που θέλουμε να
δημιουργήσουμε.

Όμοια, συνεχίζουμε με τον ορισμό τωνDatum Planes DTM3 και DTM4
με τη διαφορά ότι το καινούργιο επίπεδο τίθεται υπό γωνία αντί για
παράλληλο στο επίπεδο XΖ Plane. Η συγκεκριμένη διαδικασία παρου-
σιάζεται στην Εικόνα 3.15. Τα τρία επίπεδα δημιουργήθηκαν με σκοπό
τον σχεδιασμό μιας διατομής (Sketch) στην επιφάνειά τους, η οποία στη
συνέχεια θα προεκταθεί με την εντολή Extrude . Μετά την ολοκλήρωση
των επιπέδων το μοντέλο φαίνεται όπως στην Εικόνα 3.14.

Πλέον έχοντας ολοκληρώση τη δημιουργία των αναφορών που θα μας
χρειαστούν προχωράμε στην μοντελοποίηση των βάσεων έδρασης των
πτερυγίων. Έτσι, επιλέγουμε το εικονίδιο και στο παράθυρο προσα-
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(αʹ) Καθορισμός του σημείου PNT1

(βʹ) Καθορισμός του σημείου PNT2

Εικόνα 3.11: Καθορισμός των σημείων 1 και 2 (Datum Points).
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(αʹ) Καθορισμός του άξονα 1 (Datum Axis 1).

(βʹ) Καθορισμός του άξονα 2 (Datum Axis 2).

(γʹ) Καθορισμός του άξονα 3 (Datum Axis 3).

Εικόνα 3.13: Καθορισμός των αξόνων (Datum Axis).
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Εικόνα 3.14: Μετά την ολοκλήρωση των επιπέδων Datum Planes.

νατολισμού του Sketch, επιλέγουμε ώς Sketch Plane το επίπεδο Datum
Plane 2(DTM2), με αριστερό click από τον τρισδιάστατο χώρο ή εναλ-
λακτικά από το Model Tree. Ώς Reference επιλέγουμε το YZ Plane και
ώς Orientation το Left, καθορίζοντας έτσι τον προσανατολισμό με τον
οποίο σχεδιάζουμε. Μετά την επιβεβαίωση των επιλογών μας μεταφε-
ρόμαστε κάθετα και πάνω απο το επίπεδο Datum Plane 2 (DTM2) για
να σχεδιάσουμε τη διατομή.

Στο παράθυρο των References που εμφανίζεται επιλέγουμε από τον
τρισδιάστατο χώρο το Datum Point 2 (PNT2), ώστε το κέντρο του κύκλου
που πρόκειται να σχεδιάσουμε να είναι το σημείο 2. Μόλις αναγραφεί
το PNT2 στο παράθυρο των References, πατάμε το εικονίδιο για
να ολοκληρώσουμε την επιλογή (βλ. Εικόνα 3.18).

Όμοια δημιουργούμε τα Sketch 4 και 5 στα επίπεδα Datum Plane 3
(DTM3) και Datum Plane 4 (DTM4) αντίστοιχα, επιλέγοντας ώς References
τα Datum Point 1 (PNT1) και Datum Point 0 (PNT0) (βλ.Εικόνα 3.18).

Εικόνα 3.17: Προεπισκόπηση του μο-
ντέλου για τη μοντελοποίηση της βάσης
έδρασης πτερυγίου.

Στη συνέχεια θα δημιουργή-
σουμε ένα Extrude με βάση τη
διατομή Sketch 3. Επιλέγουμε το
Sketch 3 με αριστερό click, είτε
από το Model Tree είτε απο τον
τρισδιάστατο χώρο εργασίας. Αν
κοκκινήσει, σημαίνει ότι έχει επι-
λεγεί. Επιλέγουμε από την καρ-
τέλα Insert→ Extrude ή εναλλα-
κτικά το εικονίδιο (Extrude
Tool).

Όπως φαίνεται στην Εικόνα
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(αʹ) Καθορισμός του επιπέδου 2 (DTM2).

(βʹ) Καθορισμός του επιπέδου (DTM3)

(γʹ) Καθορισμός του επιπέδου Datum Plane (DTM4) .

Εικόνα 3.15: Καθορισμός των Datum Planes.
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(αʹ) Παράθυρο καθορισμού του
Sketch3.

(βʹ) Παράθυρο καθορισμού των
References του Sketch 3.

(γʹ) Σχεδιασμός διατομής.

Εικόνα 3.16: Δημιουργία του Sketch 3.
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3.17, στο χώρο εργασίας διατίθεται μία προεπισκόπηση του στερεού που
θα δημιουργηθεί. Επιλέγουμε την κατεύθυνση πρός το κύριο σώμα του
ρότορα ώς κατεύθυνση του Extrude. Αν η προεπισκόπηση είναι πρός
διαφορετική κατεύθυνση μπορούμε να την αλλάξουμε πατώντας το ει-
κονίδιο .

Εικόνα 3.18: Παράθυρο καθορισμού
Extrude.

Απο το παράθυρο καθορισμού
του Extrude επιλέγουμε το εικονί-
διο (Up To Next Surface) ορί-
ζοντας έτσι ότι το Extrude θα
προεκταθεί μέχρι να συναντήσει
την επόμενη επιφάνεια. Ολοκλη-
ρώνουμε το χαρακτηριστικό με

. Eπαναλαμβάνουμε την ίδια διαδικασία προεκτείνοντας τα Sketch 4
και 5 ώστε το μοντέλο να φαίνεται όπως στην Εικόνα 3.19.

3.7 Μοντελοποίηση του στόμιου στήριξης ρότορα .
Στη συνέχεια ακολουθούν τρία διαδοχικά Extrude όπου θα μοντελο-

ποιηθεί το στόμιο στήριξης του ρότορα πάνω στον άξονα της ανεμογεν-
νήτριας. Αρχικά, για τη μοντελοποίηση της βάσης του στομίου κάνουμε
χρήση της εντολής Extrude, επιλέγοντας την άνω πλευρά του βασικού
σώματος του κυλίνδρου ώς Placement και ορίζουμε το βάθος. Ολοκλη-
ρώνουμε και ακολουθούμε την ίδια διαδικασία για να μοντελοποιήσουμε
το κύριο σώμα του στομίου. Έτσι, κάνοντας χρήση της εντολής Extrude
επιλέγουμε αυτή τη φορά ώς Placement την άνω πλευρά της βάσης του
στομίου. Η διαδικασία παρουσιάζεται στην Εικόνα 3.20. To τελευταίο
Extrude παρουσιάζει μια ιδιαιτερότητα καθώς θα χρησιμοποιηθεί με
σκοπό να αφαιρεθεί υλικό από τον ρότορα, ώστε να δημιουργήσουμε την
οπή στήριξης στο κέντρο του ρότορα. Σχεδιάζουμε την κυκλική διατομή
στο Sketcher και στη συνέχεια από το παράθυρο καθορισμού του Extrude
επιλέγουμε το εικονίδιο (Remove Material) για να δημιουργήσουμε
την εσοχή στο εσωτερικό. H εσοχή θα πρέπει να διαπερνά το κεντρικό
σώμα του κυλίνδρου επομένως επιλέγουμε το εικονίδιο (Through
All) . Το σχέδιο θα φαίνεται όπως στην Εικόνα 3.21.

3.8 Μοντελοποίηση εσοχών εδρασης πτερυγίων.
Για την ολοκλήρωση του μοντέλου θα χρειαστεί να δημιουργήσουμε

τις εσοχές στις οποίες θα εφαρμόσουν τα πτερύγια. Ομοίως με πρίν, σχε-
διάζουμε την κυκλική διατομή στο Sketcher και στη συνέχεια από το πα-
ράθυρο καθορισμού του Extrude επιλέγουμε το εικονίδιο (Specified
Depth) όπου μπορούμε να καθορίσουμε το βάθος που θα εφαρμοστεί
το Extrude καθώς και το (Remove Material) για να δημιουργήσουμε
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(αʹ) Προεπισκόπηση μοντέλου για τη μο-
ντελοποίηση της βάσης έδρασης πρώτου
πτερυγίου.

(βʹ) Προεπισκόπηση μοντέλου για τη μο-
ντελοποίηση της βάσης έδρασης δεύτερου
πτερυγίου.

(γʹ) Το μοντέλο μετά την ολοκλήρωση των τριών βά-
σεων έδρασης πτερυγίων.

Εικόνα 3.19: Μοντελοποίηση των τριών βάσεων έδρασης πτερυγίων.
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(αʹ) Προεπισκόπηση του μοντέλου για τη
μοντελοποίηση της βάσης του στομίου.

(βʹ) Προεπισκόπηση του μοντέλου για τη
μοντελοποίηση του κύριου σώματος στο-
μίου.

(γʹ) Το μοντέλο μετά την ολοκλήρωση του κυρίως
σώματος στομίου.

Εικόνα 3.20: Μοντελοποίηση του στόμιου στήριξης ρότορα.
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(αʹ) Προεπισκόπηση του μοντέλου για τη μοντελο-
ποίηση της οπής στήριξης.

(βʹ) Το μοντέλο μετά την ολοκλήρωση της οπής στή-
ριξης.

Εικόνα 3.21: Μοντελοποίηση της οπής στήριξης.
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(αʹ) Προεπισκόπηση του μοντέλου για τη μο-
ντελοποίηση μιας εκ των εσοχών στήριξης
πτερυγίων.

(βʹ) Το μοντέλο μετά την ολοκλήρωση των
εσοχών στήριξης.

Εικόνα 3.22: Μοντελοποίηση εσοχών στήριξης πτερυγίων.

την εσοχή στο εσωτερικό. H εσοχή θα πρέπει να διαπερνά το κεντρικό
σώμα του κυλίνδρου μέχρι το νοητό άξονα συμμετρίας του κυλίνδρου.
Το σχέδιο θα φαίνεται όπως στην Εικόνα 3.22.

3.9 Δημιουργία τομής Α.
Για να επιβλέψουμε το εσωτερικό του μοντέλου θα δημιουργήσουμε

μια τομή. Επιλέγουμε το εικονίδιο (View Manager) που βρίσκεται
στην άνω μπάρα εργαλείων και εμφανίζεται το παράθυρο καθορισμού
του View Manager. Επιλέγουμε από την καρτέλα Xsec → New για να
δημιουργήσουμε την νέα τομή και την ονομάζουμε "Α". Κάνοντας διπλό
click στην τομή "Α" εμφανίζεται το παράθυρο καθορισμού του Menu
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(αʹ) Παράθυρο κα-
θορισμού του View
Manager.

(βʹ) Παράθυρο κα-
θορισμού του Menu
Manager.

(γʹ) Το μοντέλο μετά την ολοκλήρωση της
τομής Α.

Εικόνα 3.23: Δημιουργία τομής Α.

Manager. Επιλέγουμε τα Planar, Single και ώς επίπεδο τομής το επί-
πεδο DTM1 είτε από τον τρισδιάστατο χώρο είτε από το Model Tree.
Ολοκληρώνουμε την επιλογή μας με Done. Η διαδικασία παρουσιάζεται
στην Εικόνα 3.23.

3.10 Ολοκληρωμένο τρισδιάστατο μοντέλο.
Το ολοκληρωμένο τρισδιάστατο μοντέλο απεικονίζεται στο Σχήμα

3.24. Στα επόμενα κεφάλαια παρουσιάζεται η ανάλυσή του με τη μέ-
θοδο των Πεπερασμένων στοιχείων και η τοπολογική βελτιστοποίηση με
τη χρήση του λογισμικού ABAQUS/CAE.
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(αʹ) (βʹ)

(γʹ)

Εικόνα 3.24: Τελικό μοντέλο ρότορα.
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Κεφάλαιο 4

Επίλυση σε ABAQUS/CAE.

4.1 Εισαγωγή
Το ABAQUS/CAE 6.12 αποτελεί ένα σύνολο εφαρμογών λογισμικού

για την ανάλυση με την μέθοδο των πεπερασμένων στοιχείων και μηχα-
νικής ανάλυσης με τη χρήση Η/Υ (Computer-aided Engineering). Αρχικά
κυκλοφόρησε το 1978 από την εταιρεία SIMULIA και συνεχίζει να βελ-
τιώνεται μέχρι και σήμερα . Στην παρούσα εργασία χρησιμοποιήθηκε η
έκδοση 6.12, η οποία κυκλοφόρησε για πρώτη φορά το Μαίο του 2012
παρέχοντας στους χρήστες μεγάλο εύρος δυνατοτήτων με το εργαλείο
σχεδιασμού της τοπολογικής βελτιστοποίησης (Topology Optimization)
στο περιβάλλον εργασίας του προγράμματος. Το όνομα και το λογότυπο
του λογισμικού αυτού βασίζονται στο παιδικό εκπαιδευτικό παιχνίδι
άβακα (άβαξ) που σημαίνει "τραπέζι υπολογισμών". Το προιόν ABAQUS
αποτελείται από τέσσερα βασικά προιόντα λογισμικού, τα οποία χρησι-
μοποιούν την γλώσσα προγραμματισμού ανοιχτού κώδικα Python για
την παραμετροποίηση [3].

To Abaqus/CAE (Computer Abaqus Environment) πρόκειται για ένα
λογισμικό που χρησιμοποιείται τόσο για την μοντελοποίηση όσο και
για την ανάλυση μηχανικών εξαρτημάτων και συναρμολογημάτων (pre-
processing), καθώς και την οπτικοποίηση των αποτελεσμάτων απο την
ανάλυση των πεπερασμένων στοιχείων. Το Abaqus/CFD (Computational
Fluid Dynamics) πρόκειται για ένα λογισικό προσανατολισμένο στην
Υπολογιστική Δυναμική Ρευστών το οποίο παρέχει προηγμένες υπολογι-
στικές δυνατότητες ρευστοδυναμκής . Το Abaqus/Standard αποτελεί ένα
πρόγραμμα γενικής χρήσης με τις προαναφερθείσες δυνατότητες προσο-
μοίωσης. Συχνά αναφέρεται και ώς implicit solver διότι στη μη γραμμική
ανάλυση οι εξισώσεις επιλύονται με έναν έμμεσο (implicit) αλγόριθμο,
σε συνδυασμό με τη μέθοδο Newton. To Abaqus/Explicit ένα λογισμικό
με εξειδικευμένη χρήση και κύρια εφαρμογή στη μη-γραμμική δυναμική
ανάλυση των κατασκευών, ειδικά για δυναμικά φαινόμενα με πολύ μι-
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κρό χρόνο απόκρισης, όπως στην περίπτωση των κρουστικών φορτίων. Το
λογισμικό πακέτο ABAQUS αποτελεί ένα κώδικα πεπερασμένων στοι-
χείων, που παρέχει τη δυνατότητα της προσομοίωσης πολλών φυσικών
φαινομένων όπως:

• Στατική και δυναμική ανάλυση κατασκευών (Static/Dynamic Structure
Analysis)

• Ακουστική

• Εδαφομηχανική (Soil Mechanics)

• Μεταφορά θερμότητας και μάζας (Heat Transfer and Mass Diffusion)

• Σύζευξη διαφόρων φυσικών φαινομένων (Thermal-Stress Analysis,
Coupled Thermal-Electrical Analysis), κ.α.

Κύριο χαρακτηριστικό του ABAQUS είναι η μη γραμμική, στατική και
δυναμική ανάλυση των κατασκευών. Σήμερα βρίσκεται ανάμεσα στα κο-
ρυφαία προγράμματα που διατίθενται εμπορικά παγκοσμίως με εκτε-
ταμένη χρήση στον ακαδημαικό τομέα. Το ABAQUS διαθέτει μεγάλο
αριθμό υπορουτίνων, με τις οποίες ο χρήστης μπορεί να εισάγει στον
κώδικα επιπλέον δυνατότητες όπως μοντελα προσομοίωσης της συμπε-
ριφοράς υλικών, όπως μέταλλα, σύνθετα, πολυμερή, καουτσούκ, ενισχυ-
μένο σκυρόδεμα,γεωτεχνικά υλικά κλπ. Στις περισσότερες αναλύσεις οι
απαιτήσεις του προγράμματος σε δεδομένα εισαγωγής από τον χρήστη
είναι η γεωμετρία, η συμπεριφορά του επιλεγμένου υλικού, οι οριακές
συνθήκες και τα εφαρμοζόμενα φορτία.

Το ABAQUS/CAE μας δίνει τη δυνατότητα είτε να εισάγουμε προ-
σχεδιασμένο μοντέλο από κάποιο τρισδιάστατο πρόγραμμα, είτε να το
δημιουργήσουμε εξολοκλήρου μέσα σε αυτό. Στην παρούσα εφαρμογή
θα εισάγουμε τον ρότορα, η σχεδίαση του οποίου παρουσιάστηκε στο
προηγούμενο κεφάλαιο. Επιγραμματικά, τα στάδια της ανάλυσης του
ρότορα είναι τα εξής:

1. Εισαγωγή/Δημιουργία μοντέλου.

2. Καθορισμός μηχανικών ιδιοτήτων.

3. Τοποθέτηση στο ενιαίο σύστημα συντεταγμένων.

4. Ορισμός είδους ανάλυσης.

5. Εφαρμογή οριακών συνθηκών και φορτίσεων.

6. Ορισμός πλέγματος πεπερασμένων στοιχείων.

7. Δημιουργία εργασίας τοπολογικής βελτιστοποίησης.
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8. Υποβολή εργασίας τοπολογικής βελτιστοποίησης.

9. Επισκόπηση αποτελεσμάτων.

Στο Παράρτημα Α΄ παρουσιάζεται αναλυτικά βήμα πρός βήμα μια
απλή εφαρμογή για την κατανόηση της ανάλυσης μοντέλων στο ABAQUS/
CAE. Στην εφαρμογή αυτή παρουσιάζεται τόσο ο σχεδιασμός όσο και
η επίλυση μιας γέφυρας στο ABAQUS/CAE. Τα βασικά βήματα παρα-
μένουν τα ίδια αναλογικά σε κάθε εφαρμογή. Στα βήματα στα οποία
παρουσιάζονται παρεκκλίσεις από την κλασσική μεθοδολογία, είτε εμ-
φανίζουν ενδιαφέρον, αναφέρονται αναλυτικά στην επόμενη ενότητα.

4.2 Ανάλυση ρότορα στο ΑBAQUS/CAE

4.2.1 Ορισμός οριακών συνθηκών και φορτίσεων

Εικόνα 4.1: Eπίπεδα για τον καθο-
ρισμό των θέσεων περιστροφής.

Αρχικά, για να εισάγουμε το .stp
αρχείο επιλέγουμε από την καρτέλα
File→ Import → Part και βρίσκουμε
τη θέση του αποθηκευμένου αρχείου.
Το μοντέλο εισάγεται αυτόματα στον
τρισδιάστατο χώρο και στο μενού
Parts αναγράφεται το όνομα του αρ-
χείου. Tα επόμενα τρία στάδια, συ-
γκεκριμένα ο καθορισμός των μηχα-
νικών ιδιοτήτων του ρότορα, η τοπο-
θέτηση του ρότορα σε ένα ενιαίο σύ-
στημα συντεταγμένων και το είδος
της ανάλυσης, παραμένουν ίδια όπως
αναφέρονται στην εφαρμογή του παραρτήματος. Καθότι, το υλικό του
ρότορα είναι χάλυβας ορίζουμε την πυκνότητα 8000 𝑘𝑔/𝑚􏷢, το μέτρο
ελαστικότητας Young 200 10􏷨𝑃𝑎 και το λόγο Poisson 0.3. Πρέπει να ση-
μειωθεί ότι εφόσον θέλουμε να εφαρμόσουμε περιπτώσεις φόρτισης δεν
μπορούμε να εφαρμόσουμε μια γενική στατική ανάλυση (Static, General)
όπως στην εφαρμογή του παραρτήματος, αλλά μια ανάλυση Ιδιοτιμών
(Static, Linear Perturbation). Για την εύκολη τοποθέτηση των δυνάμεων
που αλλάζουν κατά την περιστροφή του ρότορα (0, 30, 45, 60, 90 μοίρες)
δημιουργούμε τα επίπεδα της Εικόνας 4.1.

Το πέμπτο βήμα της ανάλυσης είναι η εφαρμογή των οριακών συνθη-
κών και δυνάμεων. Θα εφαρμοστεί πάκτωση στο εσωτερικό του ρότορα
στο σημείο σύνδεσης του με την άτρακτο. Έτσι, επιλέγεται η επιφάνεια
που φαίνεται στην Εικόνα 4.2 και εφαρμόζεται μηδενική περιστροφή και
μηδενική μετατόπιση πρός όλους τους άξονες.
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Εικόνα 4.2: Eφαρμογή οριακών
συνθηκών.

Στην συνέχεια θα δημιουργηθούν
όλες οι δυνάμεις που θα χρησιμο-
ποιηθούν στις διάφορες περιπτώσεις
φόρτισης. Οι ροπές ακόμη και αν
δεν αποτελούν φορτίσεις αυτό εί-
ναι το σημείο στο οποίο πρέπει να
οριστούν, καθότι αποτελούν παρά-
γοντες οι οποίοι προκαλούν μετατό-
πιση του σώματος. Όλες οι δυνάμεις
που θα εφαρμοστούν παρουσιάζονται
στην Εικόνα 4.3. Επομένως, εφαρμό-
ζουμε τρία είδη φορτίσεων:

• Ομοιόμορφη δύναμη κάθετη στην επιφάνεια (Pressure): Η δύναμη
αυτή αντιπροσωπεύει τη δύναμη που ασκείται από τον αέρα στην
επιφάνεια του ρότορα. Η δύναμη αυτή έχει μέτρο 100 Ν και φορά
κάθετη στην επιφάνεια της Εικόνας 4.3(α'). Τόσο το μέτρο όσο και
η φορά της παραμένουν σταθερά κατά την περιστροφή του ρότορα
και δεν προκαλεί καμπτικές ροπές σε αυτόν.

• Έλξη επιφάνειας (Surface Traction): Το είδος της δύναμης αυτής
χρησιμοποιείται για την απεικόνιση της βαρυτικής δύναμης των
πτερυγίων όπως και της δύναμης πέδησης. Οι δυνάμεις αυτές ασκού-
νται στις επιφάνειες που συνδέουν το ρότορα με καθένα από τα
πτερύγια. Στην Εικόνα 4.2(β΄) απεικονίζονται οι υπό φόρτιση επι-
φάνειες. Αξίζει να σημειωθεί ότι η φορά των βαρυτικών δυνάμεων
αλλάζει κατά την περιστροφή του ρότορα. Έτσι, για να μελετηθεί
όλο το εύρος της περιστροφής αρκεί να παγώσουμε πέντε χαρακτη-
ριστικές θέσεις, στις 0, 30, 45, 60 και 90 μοίρες από τον κατακό-
ρυφο άξονα. Ωστόσο, το μέτρο των δυνάμεων παραμένει σταθερό.
Όσον αφορά τις δυνάμεις πέδησης ορίζονται με κατεύθυνση αντί-
θετη στην κίνηση για όλο το εύρος της περιστροφής. Καθότι, οι
δυνάμεις αυτές αποτελούν τις κινητήριες δυνάμεις αναμένεται η
εμφάνιση καμπτικών ροπών οι οποίες αλλάζουν ανάλογα με την
θέση περιστροφής.
Για να εφαρμόσουμε τις φορτίσεις έλξης επιφάνειας επιλέγουμε
ώς κατηγορία "Surface traction", κατά τη δημιουργία νέας δύνα-
μης. Στο επόμενο παράθυρο που εμφανίζεται μπορούμε να καθο-
ρίσουμε το είδος της πρόσφυσης πάνω στην επιφάνεια. Επιλέγουμε
General αντί για Shear, ενώ ταυτόχρονα επιλέγουμε μια ομοιό-
μορφη (Uniform) κατανομή της φόρτισης. Για να επιλέξουμε την
φορά της δύναμης ορίζουμε ένα διάνυσμα με την επιλογή δύο ση-
μείων από τον τρισδιάστατο χώρο. Τα σημεία αυτά ονομάζονται
σημεία αναφοράς (Reference Points). Τα σημεία αυτά πρέπει να
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δημιουργηθούν είτε στο Assembly Module είτε στο Part Module,
ώστε να αντιστοιχηθούν στο section μαζί με το υπόλοιπο μοντέλο
και να αναγνωριστούν σαν μέρος αυτού. Επιλέγουμε από την καρ-
τέλα Tools→Reference Point και επιλέγουμε τις συντεταγμένες του
σημείου. Τέλος, ορίζουμε το μέτρο της δύναμης με σεβασμό στις
μονάδες μέτρησης οι οποίες είναι 𝑁/𝑚􏷡.

• Καμπτικές ροπές (Moment): Οι καμπτικές ροπές είναι αποτέλεσμα
των βαρυτικών δυνάμεων και δυνάμεων πέδησης και προκαλούν τη
στρέψη του ρότορα, ανάλογα με τη θέση περιστροφής. Για να εφαρ-
μόσουμε τις καμπτικές ροπές επιλέγουμε ώς κατηγορία "Moment",
κατά τη δημιουργία νέας δύναμης. Στο επόμενο παράθυρο που εμ-
φανίζεται, στα πεδία CM1, CM2 και CM3 εισάγουμε την τιμή της
ροπής για κάθε άξονα (μονάδες Ν𝑚) και ώς επιφάνεια στην οποία
θα ασκηθεί επιλέγουμε αυτήν της Εικόνας 4.3(β'). Παρατηρούμε ότι
αν αφήνουμε ένα πεδίο κενό, εκχωρείται αυτόματα μια μηδενική
ροπή στον αντίστοιχο άξονα. Ωστόσο, θα πρέπει να εισάχθεί τουλά-
χιστον ένα μη μηδενικό στοιχείο ώστε να προσδιοριστεί το φορτίο
[12]. Οι ροπές σε αντίθεση με τις δυνάμεις απεικονίζονται με διπλά
μώβ βέλη πάνω στον αντίστοιχο άξονα (βλ. Εικόνα 4.3(γ')).

Αξίζει να αναφερθεί ότι για να εφαρμόσουμε μια δύναμη έλξης επι-
φάνειας επιλέγουμε από το μενού δημιουργίας νέας δύναμης την κατη-
γορία Surface traction. Kαθώς η δύναμη αυτή κατανέμεται ομοιόμορφα
στην επιφάνεια επιλέγουμε στο επόμενο παράθυρο Uniform και General
traction. Με το βέλος δίπλα από το vector ορίζουμε την κατεύθυνσή της,
επιλέγοντας δύο σημεία είτε από τον τρισδιάστατο χώρο είτε πληκτρο-
λογώντας τις συντεταγμένες τους. Στο κελί με την ένδειξη Magnitude
ορίζουμε το μέτρο της δύναμης σε μονάδες 𝑁/𝑚􏷡 [11].

Για να καθορίσουμε τις καμπτικές ροπές επιλέγουμε από το μενού
δημιουργίας νέας δύναμης την κατηγορία Moment. Στα κελιά με τις εν-
δείξεις CM1, CM2, CM3 καθορίζουμε τις συντεταγμένες της ροπής σε
κάθε άξονα x, y, z, σε μονάδες Ν𝑚. Aν αφήσουμε κενό κάποιο από
τα κελια αυτόματα το πρόγραμμα τα καλύπτει με μηδενικά. Στη συνέ-
χεια μας ζητείται να επιλέξουμε το σημείο στο οποίο θα εφαρμοστεί η
ροπή. Στο σημείο αυτό θα πρέπει να έχουν δημιουργηθεί στο Assembly
Module τρία σημεία αναφοράς (Reference points), στο κέντρο κάθε πλαι-
νής επιφάνειας που φαίνεται στην Εικόνα 4.3(β'), στα οποία θα εφαρμο-
στούν οι καμπτικές ροπές. Έτσι, επιλέγουμε από την κεντρική καρτέλα
Tools→Reference point και επιλέγουμε από τον τρισδιάστατο χώρο το
σημείο το οποίο θα αποτελέσει σημείο αναφοράς. Το σημείο αυτό επι-
λέγεται τυχαία καθώς θα μπορούσε να αποτελέσει οποιοδήποτε σημείο
του χώρου. Μετά την δημιουργία των σημείων θα πρέπει να αναγάγουμε
την επιφάνεια της Εικόνας 4.3(β') στο σημείο αναφοράς. Έτσι, το σημείο
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(αʹ) Eφαρμογή ομοιόμορφη δύναμη
κάθετη στην επιφάνεια (Pressure).

(βʹ) Eφαρμογή έλξης επιφανείας
(Surface Traction).

(γʹ) Eφαρμογή καμπτικών ροπών.

Εικόνα 4.3: Eφαρμογή των τριών ειδών φορτίσεων.

αυτό θα αποτελέσει το σημείο οδηγό για την κίνηση της επιφάνειας.
Η διαδικασία αυτή γίνεται στο Interaction Module από την καρτέλα
Constraints ή εναλλακτικά κάνοντας διπλό click στο εικονίδιο Constraints
του Model Tree. Στη συνέχεια, επιλέγουμε Coupling→Kinematic και από
τον τρισδιάστατο χώρο καθορίζουμε την επιφάνεια με το σημείο οδηγό
της [13].

4.2.2 Ορισμός περιπτώσεων φόρτισης
Συνολικά, δημιουργήθηκαν είκοσι πέντε δυνάμεις: τρείς βαρυτικές

δυνάμεις για κάθε πτέρυγα και σε καθεμιά από τις πέντε θέσεις περι-
στροφής, τρείς καμπτικές ροπές λόγω βαρύτητας σε κάθε πτέρυγα, τρείς
δυνάμεις πέδησης σε κάθε πτέρυγα, τρείς καμπτικές ροπές λόγω δύνα-
μης πέδησης, και τέλος η δύναμη αέρα. Στον Πίνακα 1.2 εμφανίζονται
συγκεντρωτικά τα στοιχεία αυτά.

Οι δυνάμεις αυτές θα χρησιμοποιηθούν για να οριστούν οι περιπτώ-
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σεις φόρτισης. Κατά την μοντελοποίηση δημιουργήθηκαν δέκα περιπτώ-
σεις φόρτισης, σε κανονικές συνθήκες λειτουργίας και σε λειτουργία πέ-
δησης, για καθεμιά απο τις πέντε θέσεις περιστροφής (βλ. Πίνακα 1.3).

Για να ορίσουμε τις περιπτώσεις φόρτισης επιλέγουμε από την καρ-
τέλα Load Case→ Manager και αφού την ονομάσουμε, πατάμε το ει-
κονίδιο Continue. Από τα εικονίδια και , εισάγουμε ή αφαιρούμε
αντίστοιχα, τις δυνάμεις οι οποίες θα αποτελέσουν την περίπτωση φόρτι-
σης (Load Case). Από την καρτέλα Boundary Conditions επιλέγουμε την
μοναδική οριακή συνθήκη που έχει δημιουργηθεί και την προσθέτουμε
σε κάθε περίπτωση φόρτισης ξεχωριστά .

Στη συνέχεια, δημιουργούμε το πλέγμα πεπερασμένων στοιχείων όπως
αναφέρεται στην εφαρμογή του παραρτήματος. Επιλέγουμε την ελεύ-
θερη τεχνική πλεγματοποίησης με τετράεδρα στοιχεία. Παρατηρούμε ότι
μόλις επιλεγεί η συγκεκριμένη τεχνική το μοντέλο χρωματίζεται ρόζ.
Όσον αφορά τη διακριτοποίηση επιλέγουμε ώς Seeds την τιμή 45. Δη-
μιουργώντας έτσι 85.190 στοιχεία και 123.487 κόμβους.

Για την μοντελοποίηση της τοπολογικής εργασίας καθώς και την υπο-
βολή της ακολουθούμε την ίδια διαδικασία με την εφαρμογή του Πα-
ραρτήματος Α΄. Ώς μεταβλητές σχεδιασμού επιλέχθηκαν ο όγκος και η
ενέργεια παραμόρφωσης, με στόχο την ελαχιστοποίηση της ενέργειας πα-
ραμόρφωσης και περιορισμό την ποσοστιαία μείωση του αρχικού όγκου
στο 30%.

Στο σημείο αυτό αξίζει να σημειωθεί ότι λόγω της γεωμετρίας του
ρότορα, εφαρμόστηκε ένας γεωμετρικός περιορισμός ο οποίος καθόρισε
τη συμμετρία του. Έτσι, στο Optimization Module επιλέγουμε από την
καρτέλα Geometric Restrictions→Rotational symmetry (Topology) και με
ένα νοητό τετράγωνο μαρκάρουμε το μοντέλο, καθορίζοντας έτσι την πε-
ριοχή στην οποία θα εφαρμοστεί ο περιορισμός συμμετρίας. Στο παρά-
θυρο που εμφανίζεται, ορίζουμε ώς άξονα συμμετρίας τον άξονα 3, ενώ
στο κελί "Repeating segment size (degrees)" πληκτρολογούμε την γωνία
σε μοίρες, (εδώ 120 μοίρες) που προσδιορίζει το μέγεθος του επανα-
λαμβανόμενου τμήματος. Η τιμή αυτή θα πρέπει να είναι μεγαλύτερη
ή ίση με 2°. Η εισαγωγή περιορισμός συμμετρίας στο μοντέλο μπορεί
να αυξήσει σημαντικά την ταχύτητα με την οποία το ABAQUS/CAE θα
φτάσει στην βελτιστοποιημένη δομή. Για να εφαρμοστεί ο συγκεκρι-
μένος περιορισμός δεν είναι αναγκαίο να είναι συμμετρικό το πλέγμα
πεπερασμένων στοιχείων πρίν να εκτελεστεί η τοπολογική βελτιστοποί-
ηση. Αντίθετα, στην περίπτωση βελτιστοποίησης σχήματος, το πλέγμα θα
πρέπει να είναι συμμετρικό πρίν αρχίσει η βελτιστοποίηση για να επι-
τραπεί στο ABAQUS/CAE να εντοπίσει τους συμμετρικούς κόμβους και
να διατηρήσει τη συμμετρία τους κατά την μετακίνηση των επιφανειακών
κόμβων [18].
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4.3 Aποτελέσματα

Εικόνα 4.4: Kλίμακα
των τάσεων von Mises.

O αλγόριθμος τοπολογικής βελτιστοποίησης
ολοκληρώθηκε σε 44 επαναλήψεις (Design cycle)
ενώ χρησιμοποιήθηκαν 381606 μεταβλητές. Για
το πλέγμα πεπερασμένων στοιχείων δημιουρ-
γήθηκαν 85190 τετράεδρα στοιχεία και 123487
κόμβοι. Για να εξαχθεί τo αποτέλεσμα της τοπο-
λογικής βελτιστοποίησης χρειάστηκε ο υπολογι-
στικός χρόνος των 8 ωρών. Από το Visualisation
Module μπορούμε να επιβλέψουμε τα αποτελέ-
σματα και συγκεκριμένα την κατανομή των τά-
σεων von Mises, με τους αντίστοιχους χρωματι-
σμούς, πάνω στο μοντέλο καθώς και την έγχρωμη
κλίμακα όπου φαίνεται στην Εικόνα 4.4. Στη Ει-
κόνα 4.5 φαίνεται η κατανομή των τάσεων στο μοντέλο πρίν και μετά
την αφαίρεση του υλικού. H μέγιστη τιμή που εμφανίζεται στο μοντέλο
είναι 2.342 10􏷣 𝑃𝑎 και βρίσκεται στη συναρμογή της βάσης έδρασης των
πτερυγίων με το κύριο σώμα του ρότορα. Παρατηρούμε ότι μετά την
τοπολογική βελτιστοποίηση το μοντέλο εξακολουθεί να κυμαίνεται σε
χαμηλά επίπεδα της κλίμακας των τάσεων παρά την αφαίρεση υλικού
κάτι που οδηγεί στο συμπέρασμα μίας επιτυχημένης τοπολογικής βελ-
τιστοποίησης.
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Εικόνα 4.5: Kατανομή τάσεων von Mises πρίν (αριστερά) και μετά (δεξιά) την
αφαίρεση υλικού.
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Κεφάλαιο 5

Μοντελοποίηση σε Creo
Parametric

5.1 Eισαγωγή
Το Creo αποτελεί μια οικογένεια λογισμικών τρισδιάστατου σχεδια-

σμού που αναπτύχθηκε απο την εταιρεία PTC. Το Creo αποτελείται από
εννέα λογισμικά ένα εκ των οποίων είναι το Creo Parametric. Κάθε λογι-
σμικό αποτελείται από μια σειρά εφαρμογών και δυνατοτήτων για την
ανάπτυξη πρoιόντων. Το Creo Parametric παρέχει όλες της δυνατότητες
του Pro/ Engineer με την προσθήκη της δυνατότητας ανάπτυξης προιό-
ντων με περίεργες γεωμετρίες, μέσα απο την εφαρμογή Free-Style . H
εφαρμογή αυτή παρέχει την δυνατότητα στο χρήστη να δημιουργήσει
υψηλής ποιότητας παραμετρικές επιφάνειες και ελεύθερα σχήματα, εύ-
κολα και γρήγορα. Η εταιρεία PTC άρχισε να αναπτύσσει το Creo το
2009 και τελικά κυκλοφόρησε τον Ιούνιο του 2011 [4].

5.2 Bασική ιδέα σχεδιασμού

Εικόνα 5.1: Εισαγωγή των
αποτελεσμάτων του λογιμσικού
CAE στο Creo Parametric.

Από τα αποτελέσματα της τοπολογι-
κής βελτιστοποίησης οι μηχανικοί παίρ-
νουν μία πρώτη ιδέα για την μορφή του
προιόντος, κατασκευής ή εξαρτήματος.
Στη γενική αυτή ιδέα παρουσιάζεται η
γεωμετρία του μοντέλου όσον αφορά τις
περιοχές που θα καλύπτονται από υλικό
και αυτές που μένουν κενές. Ωστόσο, τα
αποτελέσματα όπως εξάγονται από το
λογιμικό CAE επιδέχονται αλλαγές και
βελτιστοποιήσεις τις οποίες είναι σε θέση
να επιλέξει ο μηχανικός σύμφωνα με την
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εμπειρία του. Στο πρός εξέταση μοντέλο του ρότορα της παρούσας ερ-
γασίας το τελικό μοντέλο δεν αποτελεί πιστή αποτύπωση αλλά μια προ-
σπάθεια αποτύπωσης της γενικής γεωμετρίας του μοντέλου. Συγκεκρι-
μένα, το πάχος του εσωτερικού κυλίνδρου θεωρήθηκε μικρό έτσι κατά
την μοντελοποίηση του αυξήθηκε η αντίστοιχη διάμετρος.

Η βασική ιδέα για την εύκολη και γρήγορη μοντελοποίηση του ρό-
τορα είναι η εκμετάλλευση της αξονικής συμμετρίας του. Παρατηρούμε,
ότι αν διαιρέσουμε τον ρότορα σε τρία ίσα μέρη και μοντελοποιήσουμε
το ένα εκ των τριών θα μπορέσουμε στη συνέχεια να αντιγράψουμε την
γεωμετρία αυτή ώς πρός τον άξονα συμμετρίας, δημιουργώντας έτσι το
επιθυμητό στερεό. Για να αποκτήσουμε άλλο ένα εργαλείο χειρισμού
"τεμαχίζουμε" το 􏷠

􏷢 στο μισό παίρνοντας έτσι το
􏷠
􏷥 του συνολικού ρό-

τορα δημιουργώντας έτσι τον σκελετό πάνω στον οποίο θα χτίσουμε το
μοντέλο.

5.3 Μοντελοποίηση σκελετού

Εικόνα 5.2: Σκελετός μοντέλου.

Αρχικά, εισάγουμε το αρχείο .obj
στο Creo Parametric και δημιουρ-
γoύμε δύο επίπεδα (βλ. Εικόνα 5.4)
τα οποία περικλείουν το 􏷠

􏷥 του αρ-
χικού μοντέλου του ρότορα (βλ. Ει-
κόνα 5.2). Με την εντολή Τrim δη-
μιουργούμε μια τομή στο μοντέλο και
επιλέγουμε το κομμάτι το οποίο θέ-
λουμε να κρατήσουμε. Από τον τρισ-
διάστατο χώρο το ρόζ βέλος υποδει-
κνύει στο χρήστη το κομμάτι το οποίο
πρόκειται να παραμείνει. Ολοκληρώνουμε και αποθηκεύουμε το αρχείο.

Εικόνα 5.3: Αμετάβλητες επιφά-
νειες από το μοντέλο πρίν την το-
πολογική βελτιστοποίηση.

Στη συνέχεια, παρατηρούμε ότι
στα αποτελέσματα που εξήλθαν από
το το ABAQUS/CAE υφίστανται επι-
φάνειες οι οποίες παραμένουν αμε-
τάβλητες, λόγω των περιορισμών που
τέθηκαν κατά τον ορισμό της τοπολο-
γικής εργασίας. Οι επιφάνειες αυτές
μπορούν να αντιγραφούν από το αρ-
χικό μοντέλο, πρίν υποστεί τη βελτι-
στοποίηση, για να αποτελέσουν επι-
φάνειες οδηγούς. Έτσι, επιλέγουμε
από το μενού Model→Published Geometry
και στη συνέχεια τις επιφάνειες της
Εικόνας 5.3. Ολοκληρώνουμε με ΟΚ.
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(αʹ) Δημιουργία επιπέδου 1. (βʹ) Δημιουργία επιπέδου 2.

Εικόνα 5.4: Δημιουργία επιπέδων 1 και 2.

(αʹ) Δημιουργία διατομής1. (βʹ) Δημιουργία Extrude 1.

Εικόνα 5.5: Δημιουργία Revolve και Extrude 1.

Στη συνέχεια δημιουργούμε ένα συναρμολόγημα (Assembly) στο οποίο
εισάγουμε το αρχείο του σκελετού του μοντέλου, το αρχικό μοντέλο από
το οποίο αντιγράψαμε τη γεωμετρία και το αρχείο στο οποίο θα δημιουρ-
γήσουμε το μοντέλο του βελτιστοποιημένου ρότορα. Σε ένα καινούργιο
Sketch θα δημιουργήσουμε τη διατομή της Εικόνας 5.5(α') την οποία
στη συνέχεια θα προεκτείνουμε με την εντολή Revolve γύρω από τον
άξονα συμμετρίας του ρότορα μεταξύ των επιπέδων DTM1 και DTM2.
Κάνοντας χρήση της αντεγραμμένης γεωμετρίας του αρχικού ρότορα δη-
μιουργούμε ένα εκολαπτώμενο Sketch το οποίο και προεκτείνουμε με την
εντολή Extrude μέχρι την επόμενη επιφάνεια που θα συναντήσει, όπως
φαίνεται στην Εικόνα 5.5(β΄).

Για να διαμορφωθεί η εσωτερική επιφάνεια του σκελετού θα ακο-
λουθήσει μια σειρά από Sketch των οποίων θα γίνει η προβολή πάνω σε
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(αʹ) Δημιουργία διατομής 2. (βʹ) Eπιφάνεια στην οποία θα
γίνει η προβολή 1.

(γʹ) Δημιουργία διατομής 3. (δʹ) Eπιφάνεια στην οποία θα
γίνει η προβολή 2.

Εικόνα 5.6: Eπιφάνεια στην οποία θα γίνει η προβολή 2.

επιφάνειες και θα ενωθούν με καμπύλες, δημιουργώντας έτσι μια κλει-
στή διατομή την οποία στη συνέχεια θα επιλέξουμε για να αφαιρέσουμε
υλικό από το εσωτερικό του σκελετού. Επομένως, σε δύο διαφορετικά
Sketch δημιουργούμε δύο καινούργιες διατομές που φαίνονται στις Ει-
κόνες 5.6 (α') και (γ΄). Οι διατομές αυτές στην συνέχεια με την εντολή
Project θα προβληθούν πάνω στις επιφάνειες που χρωματίζονται πρά-
σινες στις Εικόνες 5.6 (β') και (δ') αντίστοιχα.

Στη συνέχεια, ακολουθεί μια σειρά από τέσσερα Sketch όπου θα σχε-
διαστούν διατομές στα δύο πλευρικά επίπεδα του σκελετού, DTM1 και
DTM2 διαμορφώνοντας έτσι όλη την πληροφορία για τον καθορισμό της
γεωμετρίας του (βλ Εικόνα 5.7). Για να δημιουργήσουμε καμπύλες αρ-
κεί να επιλέγουμε το εικονίδιο και από την καρτέλα Placement επι-
λέγουμε τις επιφάνειες που οριοθετούν την καμπύλη. Επίσης, από την
καρτέλα Ends Conditions επιλέγουμε το σημείο που θα ξεκινήσει και
αυτό που θα σταματήσει η καμπύλη. Στις Εικόνες 5.8 (α') και (β') πα-
ρουσιάζεται η δημιουργία των καμπυλών 1 και 2, οι οποίες έχουν τις
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ίδιες επιφάνειες οριοθέτησης τους. Οι χρωματισμένες με πράσινο επι-
φάνειες αποτελούν τις επιφάνειες αρχής (βλ. Εικόνα 5.8 (α')) και τέλους
(βλ. Εικόνα 5.8 (β')). Με τις καμπύλες 1 και 2 ενώνονται η διατομή 6
με την 5 από διαφορετικά σημεία. Πρέπει να αναφέρουμε ότι τα ρόζ
βέλη υποδεικνύουν την κατεύθυνση στην οποία θα κινηθεί η καμπύλη
ορίζοντας το σημείο εκκίνησης και τερματισμού. Όμοια δημιουργείται η
καμπύλη 3 με την διαφορά ότι εδώ χρησιμοποιούνται 3 σημεία για να
ενώσουν τη διατομή 6 με την προβολή 2 και τη διατομή 5 (βλ. Εικόνα 5.8
(γ')). Τέλος, οι καμπύλες 4 και 5 ενώνουν τη διατομή 6 με την προβολή
2 όπως φαίνεται στις Εικόνες 5.8 (δ') και (ε').

Αφού ενώσουμε τις διατομές με τις καμπύλες παρατηρούμε την κλει-
στή διατομή που δημιουργείται, με την οποία στη συνέχεια κάνοντας
χρήση της εντολής Boundary Blend επιδιώκουμε να δημιουργήσουμε
επιφάνεια. Κρατώντας πατημένο το πλήκτρο cntl του πληκτρολογίου επι-
λέγουμε καθεμιά καμπύλη ξεχωριστά και εφαρμόζουμε το Βoundary
Blend. Οι επιλεγμένες καμπύλες φαίνονται στην Εικόνα 5.9. Στο σημείο
αυτό το Creo έχει πλέον ολοκληρώσει την δημιουργία των επιφανειών
αλλά για να βεβαιωθούμε ότι δεν έχει δημιουργήθεί κανένα κενό μεταξύ
τους αλλά αποτελούν μια κλειστή επιφάνεια οφείλουμε να εφαρμόσουμε
την εντολή Merge, όπου ουσιαστικά καθορίζονται οι συναρμογές των
επιφανειών. .

Εικόνα 5.10: Aφαίρεση υλικού από
το εσωτερικό της επιφάνειας.

Στη συνέχεια, επεκτείνουμε ελα-
φρώς την επιφάνεια παραπλεύρως
ώστε να είμαστε σίγουροι για τις συ-
ναρμογές της στο τελικό βήμα της μο-
ντελοποίησης όταν θα αντιγράψουμε
το σκελετό, ώς πρός τον άξονα συμ-
μετρίας για να δημιουργήσουμε το
μοντέλο. Έτσι, επιλέγουμε το εικονί-
διο (Extend) και με το ποντίκι προ-
εκτείνουμε τις επιφάνειες της Εικό-
νας 5.10. Τέλος, θα πρέπει να αφαι-
ρέσουμε υλικό από το εσωτερικό της
επιφάνειας. Αυτό είναι δυνατό με την
εντολή Solidify . Aπό το παράθυρο καθορισμού ορίζουμε άν θέλουμε
να αφαιρέσουμε ή να προσθέσουμε υλικό στην επιφάνεια που έχουμε
δημιουργήσει. Συγκεκριμένα, επιλέγουμε το εικονίδιο για να αφαι-
ρέσουμε υλικό από το εσωτερικό της επιφάνειας. Ακολουθούμε την ίδια
διαδικασία για να δημιουργήσουμε την επιφάνεια της βάσης όπως φαί-
νεται στην Εικόνα 5.12.

Στη συνέχεια, θα δημιουργήσουμε την εσοχή στη βάση προεκτείνοντας
το Sketch 8. Η εσοχή προεκτείνεται μέχρι την επόμενη επιφάνεια επιλέ-
γοντας το εικονίδιο (Up to next surface) και το αποτέλεσμα φαίνεται
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(αʹ) Δημιουργία διατομής 4. (βʹ) Δημιουργία διατομής 5.

(γʹ) Δημιουργία διατομής 6. (δʹ) Δημιουργία διατομής 7.

(εʹ) Δημιουργία διατομής 8.

Εικόνα 5.7: Δημιουργία διατομών 4-8.
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(αʹ) Δημιουργία καμπύλης 1. (βʹ) Δημιουργία καμπύλης 2.

(γʹ) Δημιουργία καμπύλης 3. (δʹ) Δημιουργία καμπύλης 4.

(εʹ) Δημιουργία καμπύλης 5.

Εικόνα 5.8: Δημιουργία καμπυλών που ενώνουν τις διατομές.
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(αʹ) Δημιουργία του Βoundary
Blend 1.

(βʹ) Δημιουργία του Merge.

Εικόνα 5.9: Δημιουργία της εσωτερικής επιφάνειας.

Εικόνα 5.11: Δημιουργία επέκτασης επιφάνειας (Extend).

(αʹ) Δημιουργία του Βoundary
Blend 2.

(βʹ) Δημιουργία του
Solidify.

Εικόνα 5.12: Δημιουργία της επιφάνειας στη βάση.
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(αʹ) Δημιουργία του Εxtrude 2. (βʹ) Δημιουργία του Μirror.

(γʹ) Δημιουργία του Εxtrude 3.

Εικόνα 5.13: Tελικό μοντέλο σκελετού.

στην Εικόνα 5.13(α΄). Ακολουθούν οι εντολές Mirror και Extrude
για την ολοκλήρωση του σκελετού. Έτσι, από το παράθυρο καθορισμού
του Μirror επιλέγουμε το επίπεδο DTM2 ως πρός το οποίο θα υλοποι-
ηθεί το καθρέφτισμα. Το αποτέλεσμα της εντολής φαίνεται στην Εικόνα
5.13(β΄). Τέλος, σε ένα νέο Sketch εκολαπτώμενο στο Extrude σχεδιά-
ζουμε τη διατομή της τρύπας η οποία επιλέγουμε να διαπεράσει όλες
τις επιφάνεις που θα συναντήσει με το εικονίδιο (Through All). Το
τελικό μοντέλο του σκελετού φαίνεται στην Εικόνα 5.13(γ΄).

5.4 Δημιουργία τελικού μοντέλου ρότορα

Εικόνα 5.14: Χρήση σκελετού για
αντιγραφή γεωμετρίας.

Με την ολοκλήρωση της δημιουρ-
γίας του σκελετού μπορούμε εύκολα
να δημιουργήσουμε το τελικό μοντέλο
του ρότορα αντιγράφοντας τη γεωμε-
τρία του σκελετού αξονικά. Το μο-
ντέλο θα πρέπει να εισαχθεί στο πρό-
γραμμα ABAQUS/CAE και να εφαρ-
μοστούν οι ίδιες φορτίσεις και ορια-
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(αʹ) (βʹ)

(γʹ) (δʹ)

Εικόνα 5.15: Oλοκληρωμένο μοντέλο τοπολογικά βελτιστοποιημένου ρότορα.

κές συνθήκες, ώστε να μπορέσουμε να επιβλέψουμε την κατανομή των
τάσεων σε αυτό. Το τελικό μοντέλο όπως αυτό θα εισαχθεί στο λογισμικό
CAE για την επαλήθευσή του φαίνεται στη Εικόνα 5.15.



Κεφάλαιο 6

Επαλήθευση βελτιστοποίησης
στο ABAQUS/CAE.

6.1 Eισαγωγή
Η τοπολογική βελτιστοποίηση μέσω του ABAQUS/CAE δίνει μια πρώτη

ιδέα στο χρήστη για το πώς θα μπορούσε να είναι η γεωμετρία του βελτι-
στοποιημένου μοντέλου. Έτσι, κατά την μοντελοποίηση σε κάποιο τρισ-
διάστατο πρόγραμμα, στη περίπτωση μας το Creo Parametric, ο χρήστης
μπορεί να δοκιμάσει διάφορες πιθανές γεωμετρίες του τελικού μοντέ-
λου. Στη συνέχεια, θα πρέπει να γίνει η επαλήθευση του μοντέλου αυτού
εφαρμόζοντας τις ίδιες φορτίσεις, οριακές συνθήκες, ιδιότητες υλικού κα-
θώς και ιδιότητες πλέγματος πεπερασμένων στοιχείων. Η διαφορά είναι
ότι στο στάδιο της επαλήθευσης δεν θα υποβληθεί πρός ανάλυση μια
διαδικασία τοπολογικής βελτιστοποίησης αλλά μια εργασία απλής ανά-
λυσης (βλ. Παράρτημα Γ).

6.2 Αποτελέσματα

Εικόνα 6.1: Κλίμακα τά-
σεων von Mises στο βελτι-
στοποιημένο μοντέλο.

Για την ολοκλήρωση της ανάλυσης χρη-
σιμοποιήθηκαν, για το πλέγμα πεπερασμέ-
νων στοιχείων, 44.319 τετράεδρα στοιχεία
(45 Seeds) και ελεύθερη τεχνική πλεγματο-
ποίησης, όπως και στο αρχικό μοντέλο. Mό-
λις ολοκληρωθεί η ανάλυση μπορούμε να επι-
βλέψουμε τα αποτελέσματά της, κάνοντας
δεξί click στο μενού Jobs από το Model Tree
και επιλέγοντας Results. Αυτόματα εισαγό-
μαστε στο Visualization Module. Μπορούμε
να δούμε τυχόν μετατοπίσεις στο παραμορ-
φωμένο σώμα επιλέγοντας το εικονίδιο
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καθώς και την κατανομή των τάσεων von Mises, χρωματίζοντας αντί-
στοιχα το μοντέλο, με το εικονίδιο . Η κλίμακα των τάσεων φαίνεται
στην Εικόνα 6.1. Στον τρισδιάστατο χώρο το μοντέλο εμφανίζεται πα-
ραμορφωμένο λόγω του υψηλού συντελεστή κλίμακας (scale factor) που
εφαρμόζεται από το ABAQUS/ CAE ώστε να είναι έντονα κατανοητό
από τον χρήστη το αποτέλεσμα της παραμόρφωσης. Στο συγκεκριμένο
μοντέλο ο συντελεστής κλίμακας (Deformation Scale Factor) είναι της τά-
ξεως του 1.159 10􏷦. H μέγιστη τιμή που εμφανίζεται στο μοντέλο είναι
1.571 10􏷣 𝑃𝑎 και βρίσκεται στη βάση έδρασης των πτερυγίων. H μέγιστη
αυτή τάση είναι μικρότερη από αυτήν κατά την τοπολογική βελτιτοποί-
ηση. Παρατηρούμε ότι η κατανομή των τάσεων του μοντέλου βίσκεται σε
ικανοποιητικά χαμηλά επίπεδα χωρίς να εμφανίζει σημεία έντονης κα-
ταπόνησης. Όπως και οι παραμορφώσεις του μοντέλου σε αντιδιαστολή
με το απαραμόρφωτο είναι πολύ μικρές όπως φαίνεται στην Εικόνα 6.2.
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Εικόνα 6.2: Kατανομή τάσεων von Mises (αριστερά) και το παραμορφωμένο
σε αντιδιαστολή με το απαραμόρφωτο μοντέλο (δεξιά).
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Κεφάλαιο 7

Συμπεράσματα

H τοπολογική βελτιστοποίηση είναι μια πρόσφατα αναδυόμενη τε-
χνική που παρέχει στους μηχανικούς σχεδιασμού τις αρχικές έννοιες για
την διάταξη της δομής των υπό εξέταση μοντέλων-κατασκευών. Όμως,
επακόλουθη ανάλυση και βελτιστοποίηση του μοντέλου απαιτείται για
να εξελιχθεί από μια αρχική ιδέα στην λεπτομερή τελική μορφή. Στην πα-
ρούσα εργασία παρουσιάζεται αυτή η διαδικασία σχεδιασμού και ανάλυ-
σης του μοντέλου του ρότορα. Ο ρότορας αποτελεί ένα από τα βαρύτερα
εξαρτήματα μιας ανεμογεννήτριας, λόγω του υλικού από το οποίο είναι
κατασκευασμένος, με μεγάλο κόστος κατά την μεταφορά του. Σκοπός
της παρούσας εργασίας είναι η αφαίρεση υλικού από τον ρότορα, για
τη μείωση του βάρους όσο και του κόστους παραγωγής του, χωρίς την
μείωση της αντοχής του σε φορτίσεις.

Mε την ολοκλήρωση της επαλήθευσης του ρότορα κλείνει ο κύκλος
της βελτιστοποίησης του. Το ABAQUS/CAE παρέχει στον χρήστη την
δυνατότητα επίβλεψης των αποτελεσμάτων σε μια κλίμακα τάσεων von
Mises τόσο κατά την τοπολογική βελτιστοποίηση (βλ. Εικόνα 7.1(α')) όσο
και κατά την επαλήθευση του τοπολογικά βελτιστοποιημένου μοντέλου
(βλ. Εικόνα 7.1(β')). Παρατηρούμε ότι και στις δύο περιπτώσεις οι υψη-
λότερες τάσεις που εμφανίζονται στο μοντέλο είναι της τάξης των 10􏷣.
Συγκεκριμένα, στο τοπολογικά βελτιστοποιημένο μοντέλο είναι 2.342
10􏷢 ενώ στο επαληθευμένο μοντέλο εμφανίζονται μειωμένες στα 1.571
10􏷢 𝑃𝑎. Έτσι, επιτεύχθηκε η μείωση του όγκου του ρότορα στο 30% του
αρχικού διατηρώντας την αντοχή του στις φορτίσεις.

Η διαδικασία που παρουσιάζεται στην παρούσα εργασία μπορεί να
εφαρμοστεί σε μεγάλο φάσμα εξαρτημάτων και κατασκευών. Με την
διαδικασία της τοπολογικής βελτιστοποίησης συρρικνώνεται ο χρόνος
σχεδιασμού προιόντων, καθώς επιτρέπει στους μηχανικούς να γνωρίζουν
εξ αρχής τις κατασκευάσιμες δομές πάνω στις οποίες θα επιφέρουν στη
συνέχεια τις βελτιώσεις τους. Η τοπολογική βελτιστοποίηση εφαρμόζεται
ευρέως στην αεροναυπηγική και στη αυτοκινητοβιομηχανία, αλλά και τα
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(αʹ) Στο τοπολογικά βελ-
τιστοποιημένο..

(βʹ) Στο επαληθευμένο μο-
ντέλο.

Εικόνα 7.1: Κλίμακα τάσεων von Mises.

τελευταία χρόνια στην εμβιομηχανική και την αρχιτεκτονική ώς εργαλείο
αποτύπωση αρχικού σχεδιασμού. Άλλες εφαρμογές της τοπολογικής βελ-
τιστοποίησης είναι ανάλυση βέλτιστης ροής, ανάπτυξη και σχεδιασμός
δομών που μπορούν να χρησιμοποιηθούν ώς εύκαμπτοι μικρομηχανισμοί
(MEMS: Micro Electro Mechanical Systems) και ως μικροδομές για υλικά
με αρνητικό λόγο Poisson.
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Παράρτημα Αʹ

Απλή μοντελοποίηση στο
ABAQUS/CAE.

Για να γίνει κατανοητή η διαδικασία που ακολουθήθηκε στην πα-
ρούσα διπλωματική για την ανάλυση, επίλυση κι επαλήθευση του το-
πολογικά βελτιστοποιημένου ρότορα, παρουσιάζεται αναλυτικά, στο κε-
φάλαιο αυτό, η εφαρμογή μιας γέφυρας. Οι διαστάσεις είναι προσεγ-
γιστικές καθώς σημαντική είναι η παρουσίαση των βημάτων και όχι
αυτή καθαυτή η κατασκευή. Στην παρούσα εφαρμογή η γέφυρα μοντε-
λοποιήθηκε στο ABAQUS/CAE για λόγους εκπαιδευτικούς. Εκκινούμε

Εικόνα Αʹ.1: Αρχικό παράθυρο κατά την εκκίνηση του ABAQUS/CAE.

το ABAQUS/CAE και το αρχικό παράθυρο εμφανίζεται. Πρίν οποιαδή-
ποτε ενέργεια είναι σημαντικό να ορίσουμε το Working Directory, από
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την καρτέλα File → Set Working Directory και επιλέγουμε τον φάκελο
στον οποίο θα αποθηκεύονται όλα τα αρχεία του ABAQUS, διαφορετικά
το πρόγραμμα θα αποθηκεύει τα αρχεία σε θέσεις προεπιλεγμένες από
την εγκατάσταση του προγράμματος. Παρατηρούμε ότι στο Model Tree
καταγράφονται μια σειρά ενεργειών/βημάτων οι οποίες αποτελούν τον
οδηγό για την μοντελοποίηση του προβλήματος. Επίσης, προεκτείνοντας
το εικονίδιο από το βέλος στα δεξιά, εμφανίζονται οι
ενέργειες/βήματα σε τίτλους, ώστε ο χρήστης να μπορεί να επιλέξει σε
ποιό βήμα θέλει να μεταφερθεί. Με την επιλογή του βήματος, είτε από
το Model Tree είτε από το Module, μεταφέρεται στα διάφορα περιβάλ-
λοντα εργασίας με την εκάστοτε Μπάρα Εργαλείων (Toolbox Area) η
οποία είναι διαφορετική για το καθένα από αυτά.

Αʹ.0.1 Δημιουργία εξαρτήματος.

Εικόνα Αʹ.2: Model Tree .

Αφού έχουμε ανοίξει το βασικό πα-
ράθυρο του ABAQUS/CAE και αφού
έχουμε ορίσει το Working Directory, προ-
χωράμε στη σχεδίαση του πρώτου Sketch.
Ελέγχουμε το Module να είναι ορισμένο
ώς Part και κάνουμε διπλό
click στο εικονίδιο στο Model Tree.

Εικόνα Αʹ.3: Παράθυρο καθο-
ρισμού εξαρτήματος. .

Το παράθυρο Create Part (βλ. Εικόνα
Α'.3) εμφανίζεται παρέχοντας στο χρή-
στη τη δυνατότητα επιλογής του ονόμα
του εξαρτήματος που θα δημιουργηθεί
και των ιδιοτήτων του. Επιλέγουμε 3D,
Deformable και Solid, καθώς θέλουμε να
δημιουργήσουμε ένα τρισδιάστατο, πα-
ραμορφώσιμο στερεό. Η τιμή στο κελί
Approximate size χρησιμοποιείται από το
ABAQUS/CAE για να υπολογίσει το μέ-
γεθος του πλέγματος στο φύλλου εργα-
σίας του Sketcher. Η τιμή αυτή θα πρέπει
να είναι μεγαλύτερη από την μέγιστη διά-
σταση του τελικού μοντέλου που θέλουμε
να δημιουργήσουμε διαφορετικά, το υπό
σχεδίαση μοντέλο θα βγεί εκτός του σχε-
διαστικού πλέγματος και η πληροφορία
του θα χαθεί. Μετά τη δημιουργία του εξαρτήματος (Part), μπορούμε
να τo μετονομάσουμε, να αλλάξουμε το χώρο εργασίας καθώς και τον
τύπο της μοντελοποίησης χωρίς όμως να έχουμε τη δυνατότητα να αλ-
λάξουμε τα βασικά χαρακτηριστικά του. Ολοκληρώνουμε με
Το ABAQUS/CAE μας μεταφέρει σε ένα διαφορετικό παράθυρο που
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ονομάζεται Sketcher ώστε να σχεδιάσουμε τη διατομή της οποίας στη
συνέχεια θα επιλέξουμε το βάθος, περνώντας έτσι στις τρείς διαστά-
σεις. Από την μπάρα εργαλειών επιλέγουμε το εικονίδιο (Create
Rectangular) για να δημιουργήσουμε ορθογώνια παραλληλόγραμμη δια-
τομή που αποτελεί την βάση της γέφυρας. Για την προσθήκη διαστά-

Εικόνα Αʹ.4: Σχεδίαση διατομής στο Sketch 1.

σεων στη διατομή επιλέγουμε το εικονίδιο (Add dimension) και την
πλευρά την οποία θέλουμε να διαστασιολογήσουμε. Η τιμή ζητείται
στην Prompt Area και επιβεβαιώνουμε την επιλογή πατώντας το μεσαίο
click ή εναλλακτικά Done, από την περιοχή μηνυμάτων (Prompt Area)

.

Εικόνα Αʹ.5: Παράθυρο καθορισμού
της τρίτης διάστασης της διατομής.

Στην περίπτωση λάθους μπο-
ρούμε να αναιρέσουμε την τελευ-
ταία ενέργεια με το εικονίδιο
(Undo Tool) είτε να σβήσουμε
συγκεκριμένες διατομές χρησιμο-
ποιώντας το (Delete tool).

Το Sketcher εισάγει από μόνο
του τους περιορισμούς καθετό-
τητας και οριζοντιότητα, όπως
παρατηρείται απο το τετράγωνο
σύμβολο στις τέσσερις γωνίες
του ορθογωνίου και απο το
'H' (Horizontal) που αναγράφεται
πάνω σε μια απο τις τέσσερις
πλευρές, αντίστοιχα.

Μετά την ολοκλήρωση του Sketcher εμφανίζεται το παράθυρο κα-
θορισμού Edit Feature δίνoντας την τρίτη διάσταση της διατομής που
δημιουργήσαμε, το βάθος (Depth). Δίνουμε την τιμή του βάθους και επι-
λέγουμε ΟΚ. Με την επιβεβαίωση μεταφερόμαστε αυτόματα στον τρισ-
διάστατο χώρο εργασίας και παρατηρούμε ότι στο Model Tree, στο μενού
Parts, κάτω από το όνομα του μοντέλου, έχουν προστεθεί το χαρακτηρι-



74

Εικόνα Αʹ.6: Σχεδίαση διατομής στο Sketch2.

(αʹ) Παράθυρο καθορι-
σμού βάθους διατομής.

(βʹ) Model Tree.

Εικόνα Αʹ.7: Ολoκλήρωση σχεδίασης γέφυρας.

στικό που δημιουργήσαμε.
Με την ίδια διαδικασία δημιουργούμε σε διαφορετικά Sketch τις δια-

τομές για τα πλαινά τοιχώματα της γέφυρας. Ορίζουμε το πλάτος, ολο-
κληρώνουμε με Done από την Prompt Area και στο παράθυρο που εμφα-
νίζεται ορίζουμε το ύψος. Με την επιβεβαίωση μεταφερόμαστε αυτόματα
στον τρισδιάστατο χώρο εργασίας και παρατηρούμε ότι στο Model Tree
έχουν αναγραφεί τα χαρακτηριστικά που δημιουργήσαμε.

Αʹ.0.2 Καθορισμός μηχανικών ιδιοτήτων εξαρτήματος.
Για τον ορισμό των ιδιοτήτων του υλικού από το οποίο αποτελείται

η κατασκευή θα χρειαστεί να μεταφερθούμε στο επόμενο Module. Από
την Μπάρα Εργαλείων επιλέγουμε ή εναλλακτικά από το
Model Tree, κάνουμε διπλό click στο μενού και αυτόματα γίνε-
ται η μετατροπή του Module. Στο παράθυρο καθορισμού Edit Material
δίνουμε το όνομα του υλικού. Για να ορίσουμε τις μηχανικές του ιδιό-
τητες επιλέγουμε από την καρτέλα Mechanical → Elasticity → Elastic,
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(αʹ) Παράθυρο καθορισμού πυκνό-
τητας υλικού.

(βʹ) Παράθυρο καθορισμού τoυ μέ-
του Ελαστικότητας Young και του
λόγου Poisson.

Εικόνα Αʹ.9: Παράθυρο καθορισμού των ιδιοτήτων υλικού.

όπου ζητείται το μέτρο Ελαστικότητας Young (Young's Modulus) και ο
λόγος Poisson (Poisson's Ratio). Πληκτρολογούμε 200 10􏷨 και 0.3 αντί-
στοιχα (βλ. Εικόνα Α΄.9). Oι μονάδες μέτρησης για το μέτρο Ελαστικό-
τητας Young είναι 𝑃𝑎. Επίσης, από την καρτέλα General→Density, καθο-
ρίζουμε την πυκνότητα του υλικού πληκτρολογώντας την τιμή 8000 στο
αντίστοιχο κελί, όπως φαίνεται στην Εικόνα Α΄.9. Oι μονάδες μέτρησης
πυκνότητας που χρησιμοποιούνται από το ABAQUS/CAE είναι 𝑘𝑔/𝑚􏷢.

Εικόνα Αʹ.8: Model Tree.

Με την επιβεβαίωση μεταφε-
ρόμαστε αυτόματα στον τρισδιά-
στατο χώρο εργασίας και παρα-
τηρούμε ότι στο Model Tree έχει
προστεθεί το όνομα του υλικού
κάτω από το μενού Materials (βλ.
Εικόνα Α΄.8).

Eίναι σημαντικό μετά την σχεδίαση και τον καθορισμό των ιδιοτήτων
του υλικού της κατασκευής να δημιουργήσουμε ένα τμήμα (Section) στo
οπoίο θα αντιστοιχίσουμε το μοντέλο με το συγκεκριμένο υλικό. Στην
περίπτωση που η κατασκευή μας αποτελούνταν από διαφορετικά υλικά
και επομένως θα χρειαζόταν να δημιουργήσαμε περισσότερα από ένα
υλικά στο σημείο αυτό θα μπορουσαμε να δούμε τη λίστα με τα διαθέ-
σιμα και να αντιστοιχίσουμε το καθένα απο αυτά με το αντίστοιχο μέρος
της κατασκευής. Κάνοντας διπλό click στο μενού Sections εμφανίζεται
το παράθυρο Create Section, στο οποίο δίνουμε το όνομα στο καινούρ-
γιο τμήμα και επιλέγουμε τον τύπο και την κατηγορία του μοντέλου.
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Ολοκληρώνουμε με και το παράθυρο Edit Section εμφανίζεται.
Δεχόμαστε την προεπιλογή του υλικού ώς Χάλυβα (Steel) και επιβεβαιώ-
νουμε την επιλογή μας.

Εικόνα Αʹ.10: Model Tree.

Στο Model Tree θα πρέπει να
έχει προστεθεί η Section που μόλις
δημιουργήσαμε, όπως χαρακτηρι-
στικά φαίνεται στην Εικόνα Α΄.10,
στην οποία στη συνέχεια θα αντιστοιχίσουμε το μοντέλο μας.

Εικόνα Αʹ.11: Model Tree.

Προεκτείνοντας το μενού Parts
και κάνουμε διπλό click στο μενού
Section Assignment. Από τον τρισ-
διάστατο χώρο δημιουργούμε ένα
νοητό τετράγωνο το οποίο εμπε-
ριέχει όλη την περιοχή και επιβεβαιώνουμε την επιλογή με το μεσαίο
click του ποντικιού ή εναλλακτικά πατώντας το εικονίδιο Done από την
περιοχή μηνυμάτων. Το μοντέλο θα πρέπει να έχει πάρει χρώμα κυανό
(βλ. Εικόνα Α΄.12) και στο Model Tree να έχει προστεθεί το Section, κάτω
απο το μενού Section Assignments (βλ. Εικόνα Α΄.11).

Εικόνα Αʹ.12: Η γέφυρα κατά την αντιστοίχισή της στο τμήμα (Section).

Αʹ.0.3 Ορισμός του Αssembly και τoυ Step

Εικόνα Αʹ.13: Παράθυρο καθο-
ρισμού του Instance.

Κάθε εξάρτημα (Part) που δημιουρ-
γούμε στο ABAQUS /CAE έχει το δικό του
σύστημα συντεταγμένων και είναι ανε-
ξάρτητο από τα άλλα μέσα στο μοντέλο.
Ωστόσο ακόμη και αν το μοντέλο αποτε-
λείται απο διάφορα εξαρτήματα διαθέτει
μόνον ένα συναρμολόγημα (Assembly).

Ορίζουμε τη γεωμετρία του συναρμο-
λογήματος δημιουργώντας Instances του
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εξαρτήματος και στη συνέχεια τοποθετούμε αυτές σε ένα ενιαίο σύ-
στημα συντεταγμένων. Μια Instance μπορεί να κατηγοριοποιηθεί σε
εξαρτημένη και ανεξάρτητη. Ο προσδιορισμός αυτός δίδεται για να
διευκρινιστεί ο τρόπος με τον οποίο θα γίνει η ανάλυση με τη μέ-
θοδο των πεπερασμένων στοιχείων, δηλαδή άν κάθε Ιnstance θα ανα-
λυθεί ξεχωριστά από το αρχικό εξάρτημα ή θα θεωρηθεί ένα ενιαίο.

Εικόνα Αʹ.14: Model Tree.

Σε αυτό το σημείο λοιπόν δημιουρ-
γούμε ένα Instance στο οποίο ορίζουμε
την ταυτοποίηση των συστημάτων συντε-
ταγμένων του εξαρτήματος με το συναρ-
μολόγημα. Έτσι, από το Model Tree προε-
κτείνουμε το μενού Assembly και εφαρμόζουμε διπλό click στο εικονίδιο
Instances. Το παράθυρο Create Instance εμφανίζεται (βλ. Εικόνα Α΄.13).
Επιλέγουμε ώς τύπο του Instance, Independent και ολοκληρώνουμε πα-
τώντας ΟΚ. Με την επιβεβαίωση παρατηρούμε ότι κάτω απο το εικονίδιο
Instances έχει προστεθεί το όνομα του Part που είχαμε δημιουργήσει στο
πρώτο βήμα (βλ. Εικόνα Α΄.14).

Άν προεκτείνουμε το μενού από το Model Tree παρατη-
ρούμε ότι το ABAQUS/ CAE έχει δημιουργήσει αυτόματα ένα αρχικό
βήμα (Initial) στο οποίο και θα οριστούν οι οριακές συνθήκες. Το βήμα
αυτό δεν μπορεί ούτε να μετονομαστεί, ούτε να διαγραφεί από τον χρή-
στη. Οι υπόλοιπες δυνάμεις θα οριστούν σε ένα καινούργιο βήμα που θα
δημιουργήσουμε. Έτσι, κάνοντας διπλό click στο Step εμφανίζεται το πα-
ράθυρο Create Part (βλ. Εικόνα Α΄.15(α΄)). Επιλέγουμε Static,Genaral ώς
τύπο της ανάλυσης και ολοκληρώνουμε με Continue. Στο παράθυρο Edit
Step μπορούμε να πληκτολογήσουμε μια περιγραφή για το Step που δη-
μιουργήσαμε και επιβεβαιώνουμε την επιλογή μας (βλ. Εικόνα Α΄.13(β')).

Αʹ.0.4 Εφαρμογή οριακών συνθηκών και φορτίσεων.

Εικόνα Αʹ.16: Βαθμοί ελευθερίας.

Οι οριακές συνθήκες
καθώς και οι δυνάμεις
εξαρτώνται απο τον κα-
θορισμό του βήματος, που
περιγράφηκε στην προη-
γούμενη ενότητα, επομέ-
νως σε κάθε περίπτωση
πρέπει πρώτα να καθορί-
ζεται το βήμα στο οποίο
στη συνέχεια θα εφαρμο-
στούν οι οριακές συνθήκες
και οι δυνάμεις. Για στατικές αναλύσεις, οι οριακές συνθήκες εφαρ-
μόζονται στις περιοχές/σημεία στις/στα οποίες/α οι μετατοπίσεις είναι
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(αʹ) Παράθυρο καθορι-
σμού είδους ανάλυσης.

(βʹ) Περιγραφή και καθορισμός βασικών
ιδιοτήτων του νεόυ βήματος

Εικόνα Αʹ.15: Δημιουργίας του βήματος.

γνωστές. Αυτές οι περιοχές μπορούν να οριστούν ακίνητες (μηδενική
μετατόπιση και περιστροφή) κατά την προσομοίωση, είτε μη μηδενι-
κές μετατοπίσεις και/ή περιστροφές. Σε αυτή την εφαρμογή θα εφαρμο-
στεί πάκτωση (μηδενική μετατόπιση και περιστροφή) στις δύο πλευρές
στήριξης της γέφυρας, επομένως δε επιτρέπεται να κινηθεί προς καμία
κατεύθυνση. Οι κατευθύνσεις στις οποίες επιτρέπεται η κίνηση ορίζο-
νται ώς βαθμοί ελευθερίας (degrees of freedom(dof)). Για τον ορισμό
των οριακών συνθηκών θα χρειαστεί να μεταφερθούμε στο Module Load

ή εναλλακτικά από το Model Tree κάνοντας διπλό click
στο μενού .

Από το παράθυρο που εμφανίζεται επιλέγουμε σε ποιό Step θα εφαρ-
μοστεί η οριακή συνθήκη, καθώς και την κατηγορία και τον τύπο του. Οι
οριακές συνθήκες ορίζονται πάντα στο αρχικό βήμα της ανάλυης (Ιnitial
Step), σε αντίθεση με τις δυνάμεις οι οποίες εφαρμόζονται στο επόμενο
βήμα που δημιουργεί ο χρήστης. Ολοκληρώνουμε με ΟΚ και από τον
τρισδιάστατο χώρο επιλέγουμε την περιοχή που θα γίνει η πάκτωση.
Στο επόμενο παράθυρο ορίζουμε τους βαθμούς ελευθερίας της περιο-
χής. Στην περίπτωσή μας εφαρμόζεται πάκτωση επομένως, επιλέγουμε
ENCASTRE και επιβεβαιώνουμε με ΟΚ (βλ. Εικόνα Α'.17).

Στο ABAQUS/CAE με τον όρο Load αναφερόμαστε σε οτιδήποτε μπο-
ρεί να προκαλέσει μετατόπιση από το αρχική κατάσταση, συμπεριλαμ-
βάνοντας:
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(αʹ) Παράθυρο καθορισμού ορια-
κών συνθηκών.

(βʹ) Καθορισμός βαθμών
ελευθερίας.

(γʹ) Επιλογή περιοχής για εφαρ-
μογή της πάκτωσης.

Εικόνα Αʹ.17: Ορισμός οριακών συνθηκών.
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1. Δύναμη σε σημείο

2. Πίεση

3. Θερμότητα

4. Μη μηδενικές Οριακές συνθήκες

5. Δυνάμεις που εφαρμόζονται στο σώμα (π.χ Βαρύτητα)

Εικόνα Αʹ.18: Model Tree.

Στην πραγματικότητα δεν υφί-
σταται σημειακή δύναμη, καθώς
μια δύναμη πάντα ασκείται σε
επιφάνεια. Παρόλα αυτά, αν η
επιφάνεια είναι μικρή μπορεί να
θεωρηθεί ότι η δύναμη ασκείται σε
κάποιο σημείο.

Σε αυτή την εφαρμογή θα χρη-
σιμοποιηθεί η Πίεση ώς δύναμη, η
οποία και εφαρμόζεται πάντα κά-
θετα στην επιφάνεια. Η δύναμη
θα εφαρμοστεί στο Step-1. Έτσι,
από το Model Tree κάνοντας δι-
πλό click στο μενού εμ-
φανίζεται το παράθυρο δημιουρ-
γίας της δύναμης όπου επιλέ-
γουμε το όνομα, την κατηγορία
και τον τύπο της. Από τον τρισδιάστατο χώρο καθορίζουμε την επιφάνεια
στην οποία θα εφαρμοστεί η δύναμη και επιβεβαιώνουμε την επιλογή
μας. H τιμής της δύναμης δίνεται στο κελί Magnitude του παραθύρου
Edit load. Kαθώς η δύναμη διανέμεται ομοιόμορφα στην επιφάνεια, στο
σημείο αυτό δίνουμε τη συνολική δύναμη ανά μονάδα επιφάνειας με
μέτρο 0.5 Ν𝑚−􏷡 (βλ. Εικόνα Α'.19).

Προεκτείνοντας το μενού Steps παρατηρούμε ότι οι οριακές συνθήκες
έχουν συμπεριληφθεί στο Initial Step ενώ οι δυνάμεις στο Step-1, όπως
ορίσαμε παραπάνω(βλ. Εικόνα Α'.18). Επίσης, πρέπει να αναφέρουμε ότι
δεν έχει σημασία η σειρά με την οποία θα ορίσουμε τις οριακές συνθήκες
και τις δυνάμεις.

Αʹ.0.5 Ορισμός πλέγματος περασμένων στοιχείων
Στην ενότητα αυτή θα δημιουργηθεί το πλέγμα των πεπερασμένων

στοιχείων. Μπορούμε να καθορίσουμε την τεχνική με την οποία το πρό-
γραμμα θα δημιουργήσει το πλέγμα, το γεωμετρικό σχήμα του στοιχείου
καθώς και τον τύπο του. Εξαίρεση αποτελούν τα μονοδιάστατα μοντέλα
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(αʹ) Παράθυρο δημιουργίας δύ-
ναμης.

(βʹ) Επιλογή
περιοχής.

(γʹ) Καθορισμός ιδιοτήτων δύ-
ναμης.

Εικόνα Αʹ.19: Ορισμός δύναμης.

στα οποία δεν είναι δυνατή η επιλογή της τεχνικής που θα χρησιμοποι-
ηθεί. Η προκαθορισμένη τεχνική για κάθε μοντέλο υποδεικνύεται με το
χρώμα του μοντέλου κατά την εισαγωγή στο Module Mesh. Στην περί-
πτωση που το μοντέλο γίνει πορτοκαλί, το ABAQUS/CAE δεν μπορεί να
δημιουργήσει το πλέγμα με καμία απο τις αποθηκευμένες τεχνικές, χω-
ρίς τη βοήθεια του χρήστη. Στην προκειμένη περίπτωση χρησιμοποιείται
η τεχνική Sweep, χρωματίζοντας το μοντέλο κίτρινο.

Έχοντας εισέλθει στο Mesh Module προεκτείνουμε το μενού Parts και
επιλέγουμε το μενού Mesh. Aπό την κεντρική καρτέλα επιλέγουμε Mesh
→ Εlement Type. Στον τρισδιάστατο χώρο δημιουργούμε ένα νοητό τε-
τράγωνο με το ποντίκι περικλείοντας το μοντέλο το οποίο θα αποτελέσει
την περιοχή στην οποία θα αντιστοιχιθεί ο τύπος του στοιχείου που θα
χρησιμοποιηθεί. Επιλέγουμε Standard, Linear και ώς Family→ 3DStress.
Στο τέλος του παραθύρου γίνεται μια σύντομη περιγραφή του στοιχείου
που θα χρησιμοποιηθεί και ολοκληρώνουμε με ΟΚ και Done από την
περιοχή μηνυμάτων.

H βασική διαδικασία για την δημιουργία του πλέγματος ολοκληρώνε-
ται σε δύο στάδια. Αρχικά, δημιουργούνται πλασματικoί κόμβοι (Seeds)
στα σύνορα των επιφανειών με σκοπό τον καθορισμό των θέσεων των
συνοριακών πραγματικών κόμβων του πλέγματος του φορέα. Σε δεύτερο
στάδιο δημιουργείται το πλέγμα. Επιλέγουμε τον αριθμό των κόμβων με
βάση το μέγεθος του επιθυμητού στοιχείου που θα χρησιμοποιηθεί ή τον
αριθμό των στοιχείων που θέλουμε σε μια ακμή [14].

Από το κενρικό μενού επιλέγουμε την καρτέλα Seed → Part και το
παράθυρο Global Seeds εμφανίζεται. Στο παράθυρο αυτό φαίνεται το
μέγεθος του στοιχείου που είναι προεπιλεγμένο και καθορίζεται απο
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(αʹ) Παράθυρο oρισμού των κόμ-
βων.

(βʹ) Τοποθέτηση κόμβων.

(γʹ) Γέφυρα μετά την δη-
μιουργία του πλέγματος.

Εικόνα Αʹ.20: Δημιουργία πλέγματος πεπερασμένων στοιχείων.

το μέγεθος του μοντέλου. Στην περίπτωση που θέλουμε να μειώσουμε
την διακριτοποίηση αρκεί να μειώσουμε τον αριθμό αυτό. Ολοκληρώ-
νουμε με ΟΚ. Για να δημιουργηθεί πλέον το πλέγμα επιλέγουμε Mesh→
Part και επιβεβαιώνουμε απο την περιοχή μηνυμάτων (βλ. Εικόνα Α΄.20).
Συχνά είναι χρήσιμο να γνωρίζουμε τον αριθμό των στοιχείων και των
κόμβων. Αυτό είναι εφικτό από την καρτέλα View→ Part Display Options
του κεντρικού μενού και από την καρτέλα Mesh επιλέγουμε Show node
labels και Show elements labels. Οι αριθμημένοι κόμβοι και τα στοιχεία
εμφανίζονται στον τρισδιάστατο χώρο.

Αʹ.1 Τοπολογική βελτιστοποίηση σε ABAQUS/CAE

Αʹ.1.1 Εισαγωγή
Μπορούμε να χρησιμοποιήσουμε το Module Optimization για να εκτε-

λέσουμε τις εξής εργασίες [15]:

• Αρχικά να δημιουργήσουμε μια εργασία τοπολογικής βελτιστοποί-
ησης (Οptimization Task)
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• Να oρίσουμε την τιμή που εξάγεται απο την βελτιστοποίηση (Design
Response). Mια μεταβλητή σχεδιασμού μπορεί να εξάγεται απευ-
θείας από τα δεδομένα εξόδου (Output Database), όπως για παρά-
δειγμα ο όγκος.

• Να ορίσουμε την αντικειμενική συνάρτηση (Οbjective function), η
οποία καθορίζει το στόχο της βελτιστοποίησης και αναφέρεται στην
τιμή της μεταβλητής σχεδιασμού ή ένα συνδυασμό μεταβλητών σχε-
διασμού. Για παράδειγμα, η αντικειμενική συνάρτηση της βελτιστο-
ποίησης μπορεί να είναι η ελαχιστοποίηση της συνολικής ενέργειας
παραμόρφωσης του μοντέλου (Μεγιστοποίηση ακαμψίας).

• Να ορίσουμε τους περιορισμούς (Conditions). Οι περιορισμοί κα-
θορίζουν τις αλλαγές οι οποίες λαμβάνουν χώρα είτε στην τοπο-
λογία είτε στο σχήμα του μοντέλου. Για παράδειγμα, ο όγκος του
βελτιστοποιημένου μοντέλου μπορεί να περιορίστεί στο 50% του
αρχικού. Eάν, ένας περιορισμός παραβιάζεται, η βελτιστοποίηση
δεν μπορεί να ολοκληρωθεί.

• Nα ορίσουμε γεωμετρικούς περιορισμούς (Geometric Restriction).
Oι περιορισμοί αυτοί καθορίζουν τις αλλαγές οι οποίες μπορούν
να γίνουν αποκλειστικά στην τοπολογία του μοντέλου. Μπορούμε,
για παράδειγμα, να παγώσουμε περιοχές ώστε να μην είναι δυνατή
η αφαίρεση υλικού απο αυτές.

• Τέλος, να ορίσουμε μια συνθήκη τερματισμού του αλγορίθμου (Stop
Condition). Για παράδειγμα, η βελτιστοποίηση μπορεί να θεωρηθεί
ολοκληρωμένη μετά από ένα συγκεκριμένο αριθμό επαναλήψεων.

Αʹ.1.2 Δημιουργία εργασίας τοπολογικής βελτιστοποίησης
Η τοπολογική βελτιστοποίηση υποστηρίζει δύο αλγορίθμους, τον γε-

νικό αλγόριθμο, που είναι πιο ευέλικτος και έχει εφαρμογές σε περισ-
σότερα προβλήματα και τον αλγόριθμο ακαμψίας που είναι πιο απο-
τελεσματικός αλλά με περιορισμένες δυνατότητες. Απο προεπιλογή το
ABAQUS/CAE χρησιμοποιεί το γενικό αλγόριθμο, ωστόσο ο χρήστης
μπορεί να επιλέξει ποιόν επιθυμεί για κάθε περίπτωση, καθώς κάθε
αλγόριθμος έχει διαφορετική προσέγγιση για τον προσδιορισμό της βέλ-
τιστοποιημένης λύσης.

Ο γενικός αλγόριθμος τοπολογικής βελτιστοποίησης ρυθμίζει την πυ-
κνότητα και την ακαμψία των μεταβλητών σχεδιασμού, ενώ προσπαθεί
για την ικανοποίηση της αντικειμενικής συνάρτησης και των περιορι-
σμών. Ο γενικός αυτός αλγόριθμος είναι μια παραλλαγή του αλγορίθ-
μου περιγράφεται στο εγχειρίδιο Bendsøe and Sigmund (2003) [9]. Σε
αντίθεση, ο δεύτερος αλγόριθμος είναι βασισμένος στην ακαμψία του
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σώματος πρός βελτιστοποίηση. Ο λόγος της αποτελεσματικότητάς του
έγκειται στο γεγονός ότι χρησιμοποιεί ώς δεδομένα εισόδου την ενέργεια
παραμόρφωσης και τις καταπονήσεις στους κόμβους, επομένως απο-
φεύγεται ο υπολογισμός της τοπικής ακαμψίας των μεταβλητών σχεδια-
σμού. Ο συγκεκριμένος αλγόριθμος αναπτύχθηκε απο το Πανεπιστήμιο
του Karlsruhe, της Γερμανίας.

Aρχικά θα δημιουργήσουμε μια εργασία τοπολογικής βελτιστοποί-
ησης κάνοντας διπλό click στο εικονίδιο . Kαθώς θέ-
λουμε να βελτιστοποιήσουμε την τοπολογία του μοντέλου και όχι το
σχήμα του απο το παράθυρο δημιουργίας νέας εργασίας βελτιστοποί-
ησης, που εμφανίζεται επιλέγουμε Topology optimization ώς τύπο της
βελτιστοποίησης (βλ. Εικόνα Α΄.22).

Εικόνα Αʹ.21: Model Tree.

Από τον τρισδιάστατο χώρο δημιουρ-
γούμε με το ποντίκι ένα νοητό τετράγωνο
στο οποίο περικλείουμε το μοντέλο και
επιλέγουμε Done ή εναλλακτικά μεσαίο
πλήκτρο του ποντικιού. Στο επόμενο παράθυρο μπορούμε να επεξεργα-
στούμε την εργασία βελτιστοποίησης θέτοντας κάποιους περιορισμούς.
Συγκεκριμένα, επιλέγουμε να αφήσουμε απαραμόρφωτες τις επιφάνειες
που που υπόκεινται σε φορτίσεις και οριακές συνθήκες. Παρατηρούμε
ότι μετά την επιβεβαίωση της επιλογής μας, αναγράφεται η εργασία στο
Model Tree (βλ. Εικόνα Α΄.21).

Αʹ.1.3 Oρισμός μεταβλητών σχεδιασμού
Για τα γραμμικά συστήματα η ενδοτικότητα, μέγεθος το οποίο θεω-

ρείται το αντίστροφο της ακαμψίας, ορίζεται ως το άθροισμα της ενέρ-
γειας παραμόρφωσης όλων των στοιχείων. Σε ένα ιδανικό σύστημα παίρ-
νει πολύ χαμηλές τιμές, επομένως αναμένεται η μεγιστοποίηση της συνο-
λικής ακαμψίας για τα συστήματα αυτά. Υπό την εφαρμογή ενός φορτίου,
η ενέργεια παραμόρφωσης μειώνεται όταν η δομή γίνεται μαλακότερη.
Ώς αποτέλεσμα, η προσπάθεια ελαχιστοποίησης της ενέργειας παρα-
μόρφωσης μπορεί να οδηγήσει σε μια άκαμπτη δομή. Για συστήματα
που προβλέπονται έντονες μετατοπίσεις θα πρέπει η ενέργεια παρα-
μόρφωσης να τίθεται πρός μεγιστοποίηση. Η τοπολογική βελτιστοποίηση
λαμβάνει υπόψιν της την ενέργεια παραμόρφωσης όλων των στοιχείων
του μοντέλου ώς εκ τούτου, εφόσον επιλεγεί η ενέργεια παραμόρφωσης
και ώς στόχος της βελτιστοποίησης θα πρέπει να επιλεγεί ολόκληρο το
μοντέλο [16]. Ώς όγκο (Volume) ορίζεται το άθροισμα των επιμέρους
όγκων των στοιχείων από τα οποία αποτελείται το μοντέλο. Για τα πε-
ρισσότερα προβλήματα βελτιστοποίησης, θα πρέπει να εφαρμοστεί ένας
περιορισμός όγκου. Για παράδειγμα, άν προσπαθήσουμε να μειώσουμε
την ενέργεια παραμόρφωσης (μεγιστοποίηση ακαμψίας) και δεν εφαρ-
μόσουμε κάποιον περιορισμό όγκου, το ABAQUS/ CAE απλά θα γεμίσει
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(αʹ) Παράθυρο δημιουρ-
γίας νέας εργασίας τοπο-
λογικής βελτιστοποίηση.

(βʹ) Επιλογή περιοχής που
υπόκειται σε τοπολογικής
βελτιστοποίησης.

(γʹ) Παράθυρο για καθο-
ρισμό των απαραμόρφω-
των περιοχών.

Εικόνα Αʹ.22: Δημιουργία νέας εργασίας τοπολογικής βελτιστοποίησης γέφυ-
ρας.

την περιοχή σχεδίασης με υλικό [16].
Οι μεταβλητές του προβλήματος συνδέονται με μια περιοχή του μο-

ντέλου, ωστόσο αποτελούν μια βαθμωτή τιμή, όπως για παράδειγμα η
μέγιστη τάση μιας περιοχής ή ολόκληρου του μοντέλου. Oι μεταβλητές
αυτές μπορούν να διαβαστούν από το output database αρχείο.

Από το κεντρικό μενού επιλέγουμε Design Response→ Create ή εναλ-
λακτικά Design Response → Manager →Create. Aπό την περιοχή μηνυ-
μάτων καλούμαστε να επιλέξουμε την περιοχή στην οποία αναφέρονται
οι μεταβλητές σχεδιασμού και επιλέγουμε ολόκληρο το μοντέλο (Whole
Model), καθώς θα επιλέξουμε ώς μεταβλητή την ενέργεια παραμόρφω-
σης. Στο επόμενο παράθυρο καθορίζονται όλες οι μεταβλητές του προ-
βλήματος. Επιλέγουμε Strain energy→ Strain energy και επιβεβαιώνουμε
με ΟΚ. Παρατηρούμε ότι στον Design Response Manager έχει προστεθεί
η D-Response-1. Aκολουθούμε την ίδια διαδικασία και επιλέγοντας ώς
μεταβλητή τον όγκο (Volume→ Volume) στο παράθυρο καθορισμού των
μεταβλητών (βλ. Εικόνα Α'.23).

Αʹ.1.4 Aντικειμενική συνάρτηση
Η αντικειμενική συνάρτηση καθορίζει το στόχο της βελτιστοποίησης.

Για να ορίσουμε την αντικειμενική συνάρτηση επιλέγουμε μια μετα-
βλητή σχεδιασμού είτε συνδυασμό αυτών και ορίζουμε τον στόχο, για
παράδειγμα ελαχιστοποίηση της ενέργειας παραμόρφωσης. Άν ο χρή-
στης επιλέξει την ελαχιστοποίηση ή μεγιστοποίηση των μεταβλητών, το



Αʹ.1. ΤΟΠΟΛΟΓΙΚΗ ΒΕΛΤΙΣΤΟΠΟΙΗΣΗ ΣΕ ABAQUS/CAE 86

(αʹ) Παράθυρο καθορισμού μεταβλητών του
προβλήματος.

(βʹ) Design Response Manager.

Εικόνα Αʹ.23: Kαθορισμός μεταβλητών του προβλήματος (Design Response).
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(αʹ) Παράθυρο δημιουργίας αντι-
κειμενικής συνάρτησης.

(βʹ) Παράθυρο καθορισμού αντι-
κειμενικής συνάρτησης.

(γʹ) Objective Function Manager.

Εικόνα Αʹ.24: Καθορισμός αντικειμενικής συνάρτησης (Objective Function).

ABAQUS/ CAE υπολογίζει την αντικειμενική συνάρτηση προσθέτοντας
καθεμιά απο τις τιμές των μεταβλητών. Επίσης, είναι δυνατός ο ορι-
σμός ενός συντελεστή στάθμισης (weighting factor), oποίος έχει προεπι-
λεγμένη τιμή 1.0. Για τα περισσότερα μοντέλα που υποβάλλονται προς
βελτιστοποίηση δεν χρειάζεται καμία ενέργεια, ωστόσο σε ορισμένες πε-
ριπτώσεις μπορεί να χρειαστεί να μεταβληθεί η προεπιλεγμένη τιμή για
να ισορροπήσει την επίδραση της αντικειμενικής συνάρτησης, η οποία
παίζει κυρίαρχο ρόλο στην βελτιστοποίηση. Για την βελτιστοποίηση της
τοπολογίας του μοντέλου η προεπιλεγμένη τιμή αναφοράς είναι 0.0, σε
αντίθεση με την βελτιστοποίηση Σχήματος όπου υπολογίζεται απο το
ίδιο το πρόγραμμα. Στο σημείο αυτό πρέπει να υπογραμμίσουμε ότι ο
όγκος δεν μπορεί να χρησιμοποιηθεί ώς αντικειμενική συνάρτηση [17].

Έτσι, από το κεντρικό μενού επιλέγουμε Objective Function → Create
ή εναλλακτικά Objective Function→ Manager →Create. Στο παράθυρο
καθορισμού της αντικειμενικής συνάρτησης επιλέγουμε την ελαχιστοποί-
ηση της συνολικής ενέργειας παραμόρφωσης του μοντέλου (βλ. Εικόνα
A' 24).

Αʹ.1.5 Περιορισμοί
Οι περιορισμοί καθορίζουν τις αλλαγές οι οποίες λαμβάνουν χώρα

είτε στην τοπολογία είτε στο σχήμα του μοντέλου κατά τη διάρκεια της
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βελτιστοποίησης. Oι περιορισμοί όπως και η αντικειμενική συνάρτηση,
εξάγονται απο τις μεταβλητές του προβλήματος. Για παράδειγμα, μπο-
ρούμε να καθορίσουμε είτε ότι ο όγκος πρέπει να μειωθεί κατά 45% είτε
ότι η απόλυτη μετατόπιση σε μια περιοχή δεν πρέπει να υπερβαίνει το 1
mm. Mπορoύμε επίσης να εφαρμόζουμε στην κατασκευή και γεωμετρι-
κούς περιορισμούς που είναι ανεξάρτητοι από την βελτιστοποίηση. Για
παράδειγμα, η επιφάνεια της διαμέτρου ενός εδράνου [17].

Η ικανοποίηση των περιορισμών έχει προτεραιότητα σε σχέση με την
ελαχιστοποίηση ή μεγιστοποίηση της αντικειμενικής συνάρτησης. Ο αλ-
γόριθμος βελτιστοποίησης αρχίζει να ελαχιστοποιεί ή μεγιστοποιεί τους
στόχους μόνον αφού ικανοποιούνται οι περιορισμοί. Eπομένως, εάν ένας
περιορισμός παραβιάζεται, η βελτιστοποίηση δεν είναι εφικτή. Για να
ορίσουμε έναν περιορισμό επιλέγουμε τη μεταβλητή (Design Response)
ή έναν συνδυασμό αυτών και καθορίζουμε την τιμή του περιορισμού. Σε
μια γενική τοπολογική βελτιστοποίηση ο περιορισμός μπορεί να είναι
μικρότερος από, μεγαλύτερος από, ή ίσος με μια σταθερή τιμή ή ένα
κλάσμα της αρχικής τιμή της μεταβλητής πρίν ξεκινήσει η βελτιστοποί-
ηση. Είναι προφανές, ότι δεν μπορούν να οριστούν περιορισμοί ίδιου
τύπου, όπως για παράδειγμα ο όγκος σε ολόκληρο το μοντέλο και σε
μια μικρότερη περιοχή. Στο παρόν παράδειγμα θα πρέπει ο όγκος του
βελτιστοποιημένου μοντέλου να είναι το 20% του αρχικού όγκου.

Από το κεντρικό μενού επιλέγουμε Constraint → Create ή εναλλα-
κτικά Constraint → Manager → Create. Στο παράθυρο καθορισμού του
περιορισμού επιλέγουμε την μεταβλητή του όγκου (D-Response-2) που
δημιουργήσαμε σε προηγούμενη ενότητα και ορίζουμε τον όγκο του βελ-
τιστοποιημένου μοντέλου να είναι μικρότερος ή ίσος από τον αρχικό πρίν
ξεκινήσει η βελτιστοποίηση. Eπιβεβαιώνουμε με ΟΚ (βλ. Εικόνα A' 25).

Αʹ.1.6 Υποβολή εργασίας τοπολογικής βελτιστοποίησης.
Μόλις μοντελοποιηθεί το πρόβλημα και υποβληθεί πρός ανάλυση το

ABAQUS/CAE κάνοντας χρήση ενός επαναληπτικού αλγόριθμου αναζητά
την βέλτιστη λύση του προβλήματος. Κάθε επανάληψη ονομάζεται σχε-
διαστικός κύκλος (design cycle) [19]. Σε κάθε κύκλο τοπολογικής βελτι-
στοποίησης:

1. Ανανεώνονται οι ιδιότητες υλικού και τα στοιχεία στο πλέγμα των
πεπερασμένων στοιχείων.

2. Το τροποποιημένο μοντέλο στέλνεται στον αναλύτη.

3. Διαβάζονται τα αποτελέσματα της ανάλυσης.

4. Aποφασίζεται αν θα σταματήσει η βελτιστοποίηση, είτε επειδή η
λύση είναι βέλτιστη είτε επειδή ικανοποιείται κάποια συνθήκη τερ-
ματισμού.
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(αʹ) Παράθυρο δημιουργίας περιο-
ρισμών.

(βʹ) Παράθυρο καθορισμού περιο-
ρισμών.

(γʹ) Constraint Manager.

Εικόνα Αʹ.25: Καθορισμός περιορισμών (Constraint).
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(αʹ) Παράθυρο καθορισμού της
διαδικασίας βελτιστοποίησης.

(βʹ) Optimization Process Manager.

Εικόνα Αʹ.27: Καθορισμός διαδικασίας βελτιστοποίησης (Optimization
Process).

Εικόνα Αʹ.26: Επαναληπτικός αλγό-
ριθμος.

Επομένως, για να υποβληθεί
η εργασία πρός ανάλυση κά-
νουμε διπλό click στο εικονί-
διο εμφανί-
ζεται το παράθυρο καθορισμού
της διαδικασίας βελτιστοποίησης
(Optimization process). Στο σημείο
αυτό ο χρήστης μπορεί να ορί-
σει το μέγιστο επιτρεπτό αριθμό
επαναλήψεων για την ολοκλήρωση
της διαδικασίας βελτιστοποίησης.
Στην παρούσα εφαρμογή επιλέ-
χθηκε ώς ανώτατο όριο ο αριθ-
μός των 50 επαναλήψεων. Oλο-
κληρώνουμε με ΟΚ και με Submit
υποβάλλεται η εργασία πρός ανά-
λυση.
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Αʹ.1.7 Aποτελέσματα

Εικόνα Αʹ.28: Optimization Process
Manager.

Mόλις στον Optimization
Process Manager εμφανιστεί η
ένδειξη της ολοκλήρωσης της
διαδικασίας επιλέγουμε το ει-
κονίδιο Results για να αξιολο-
γηθούν τα αποτελέσματα. Με-
ταφερόμαστε αυτόματα στο
Module Visualization και στον
τρισδιάστατο χώρο εμφανίζονται τα αποτελέσματα της βελτιστοποίησης
(βλ.Εικόνα Α΄.28).

Για να εξαγάγουμε τα αποτελέσματα της τοπολογικής βελτιστοποί-
ησης επιλέγουμε από την καρτέλα File → Export → Part. Στο παράθυρο
που εμφανίζεται επιλέγουμε ώς μορφή αρχείου .stp και ταυτόχρονα το
όνομα του αρχείου και την θέση που θα γίνει η αποθήκευση. Πλέον μπο-
ρούμε να δημιουργήσουμε τη γεωμετρία του βελτιστοποιημένου μοντέ-
λου στο τρισδιάστατο πρόγραμμα Creo Parametric, όπως παρουσιάζεται
στο επόμενο κεφάλαιο, ώστε στη συνέχεια να γίνει η επαλήθευση του
ξανά με τη χρήση του ABAQUS/CAE.
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(αʹ)

(βʹ)

Εικόνα Αʹ.29: Αποτελέσματα (Results).



Παράρτημα Βʹ

Απλή μοντελοποίηση στο Creo
Parametric

Εικόνα Βʹ.1: Εισαγωγή του μοντέλου
στο Creo Parametric.

Εκκινούμε το Creo Parametric
και το αρχικό παράθυρο εμφανί-
ζεται. Πρίν οποιαδήποτε ενέργεια
είναι σημαντικό να ορίσουμε το
Working Directory, από την καρ-
τέλα File→ Set Working Directory
και επιλέγουμε τον φάκελο στον
οποίο θα αποθηκεύονται όλα τα
αρχεία του Creo Parametric, δια-
φορετικά το πρόγραμμα θα απο-
θηκεύει τα αρχεία σε θέσεις προεπιλεγμένες από την εγκατάσταση του
προγράμματος. Στη συνέχεια, επιλέγουμε από την καρτέλα File →Open
και στη συνέχεια το αρχείο των αποτελεσμάτων από την τοπολογική
βελτιστοποίηση, με τη μορφή .stp, από την τοποθεσία αποθήκευσης που
είχαμε επιλέξει.

Παρατηρούμε ότι στο Model Tree καταγράφονται τα τρία βασικά
επίπεδα στα οποία έχει γίνει η τοποθέτηση της γέφυρας. Το Extrude
ανήκει στη κατηγορία των Sketched Features, δηλαδή απαιτείται η σχε-
δίαση μιας διατομής για την ολοκλήρωσή του. Επομένως, αρχικά δη-
μιουργούμε ένα Sketch αντιγράφοντας την περίμετρο ενός εκ των
τοιχωμάτων της γέφυρας, χρησιμοποιώντας τα εργαλεία και για
τη δημιουργία ευθειών και τόξων αντίστοιχα. Ολοκληρώνουμε με .
Για να δημιουργήσουμε στερεό από μια διατομή, ακολουθούμε τις ίδιες
ενέργειες με τη μοντελοποίηση στο Pro/ENGINEER. Από το Model Tree
επιλέγουμε το Sketch 1 και προεκτείνουμε την διατομή με την εντολή
Extrude . Το σχέδιο φαίνεται στην Εικόνα Β'.2.
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(αʹ) Διατομή στο Sketch1. (βʹ) Δημιουργία Extrude 1.

Εικόνα Βʹ.2: Δημιουργία Extrude της διατομής 1.

Εικόνα Βʹ.3: Διατομής στο Sketch 2.

Στη συνέχεια, θα δημιουργή-
σουμε τις εσοχές στο τοίχωμα της
γέφυρας όπως ακριβώς επιτάσσει
η κατανομή υλικού από την το-
πολογική βελτιστοποίηση. Σε ένα
καινούργιο Sketch με τα ίδια
εργαλεία που χρησιμοποιήθηκαν
για την δημιουργία ευθειών και
τόξων στο Sketch 1 δημιουργούμε
τις διατομές της Εικόνας Β΄.3.

Παρατηρούμε ότι η κατανομή
υλικού στο μοντέλο εμφανίζει μια συμμετρία την οποία μπορούμε να
εκμεταλλευτούμε για να δημιουργήσουμε ένα παραμετρικό μοντέλο που
να επιδέχεται αλλαγές εύκολα και γρήγορα. Με την εντολή Mirror μπο-
ρούμε να καθρεφτίσουμε ώς προς κάποιο επίπεδο, κάθε χαρακτηριστικό
που έχει ήδη καθοριστεί στο μοντέλο. Έτσι, θα καθρεφτίσουμε το Sketch
2 ώς προς ένα επίπεδο 4 (DTM4), που θα διέρχεται απο τον άξονα συμ-
μετρίας της γέφυρας και θα είναι παράλληλο στο επίπεδο 2 (DTM2).
Χρησιμοποιούμε τις εντολές Mirror και Datum Plane αντίστοιχα.
Στην Εικόνα Β΄.4 παρουσιάζεται η διαδικασία. Επαναλαμβάνουμε την
διαδικασία για να καθρεφτίσουμε τις διατομές των εσοχών στο δεύτερο
τοίχωμα της γέφυρας (βλ. Εικόνα B΄.5).

Από το παράθυρο καθορισμού του Extrude επιλέγουμε την εντολή
Remove Material για να αφαιρέσουμε υλικό από τις διατομές του
Sketch 2 (βλ Εικόνα Β΄.6(α')). Με την εντολή Mirror θα καθρεφτίσουμε
το χαρακτηριστικό Extrude, που δημιουργήσαμε ώς πρός το επίπεδο 4.
Το σχέδιο φαίνεται στην Εικόνα Β΄.6(β').

Στο επόμενο βήμα ακολουθεί μια σειρά επαναλαμβανόμενων εντο-
λών Mirror για τον καθρεφτισμό του σχεδίου της Εικόνας Β.6(β') ώς
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(αʹ) Παράθυρο καθορι-
σμού του επιπέδου DTM4.

(βʹ) Δημιουργία επιπέδου DTM4.

(γʹ) Δημιουργία Mirror 1.

Εικόνα Βʹ.4: Δημιουργία επιπέδου 4 και Mirror 1.
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(αʹ) Παράθυρο καθορι-
σμού του επιπέδου DTM5.

(βʹ) Δημιουργία επιπέδου DTM5.

(γʹ) Δημιουργία Mirror 2.

Εικόνα Βʹ.5: Δημιουργία επιπέδου 5 και Mirror 2.

(αʹ) Extrude της διατομής 2. (βʹ) Δημιουργία Mirror 3.

Εικόνα Βʹ.6: Δημιουργία Extrude 2 και Mirror 3.
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(αʹ) Δημιουργία Mirror 4. (βʹ) Δημιουργία Mirror 5.

(γʹ) Δημιουργία Mirror 6.

Εικόνα Βʹ.7: Δημιουργία Mirror 4, 5 και 6.

προς το επίπεδο 5, με σκοπό την ολοκλήρωση της κατασκευής των δύο
τοιχωμάτων της γέφυρας. Η διαδικασία παρουσιάζεται σταδιακά στην
Εικόνα Β΄.7 Στη συνέχεια, θα δημιουργήσουμε τη βάση της γέφυρας με
την εντολή Extrude. Όπως παρουσιάστηκε και παραπάνω, δημιουργούμε
σε ένα καινούργιο Sketch την ορθογώνια παραλληλόγραμμη διατομή της
βάσης και στη συνέχεια με την εντολή Extrude την προεκτείνουμε καθο-
ρίζοντας το βάθος της. Το σχέδιο φαίνεται στην Εικόνα Β΄.8.

Τέλος, θα δημιουργήσουμε τη στρογγύλευση των ακμών της γέφυ-
ρας. Με αυτόν τον τρόπο αποφεύγεται η συγκέντρωση υψηλών τάσεων
στις ακμές. Έτσι το μοντέλο γίνεται πιο ανθεκτικό φέροντας μεγαλύτερα
φορτία. Επίσης, οι αιχμηρές ακμές μπορούν εύκολα να πάθουν βλάβη,
όσο και να προκαλέσουν τραυματισμό στους χρήστες. Είναι άξιο να ση-
μειωθεί ότι αποφεύγουμε να εφαρμόσουμε Rounds στα σημεία στήριξης
της γέφυρας για να αποτραπεί η αλλοίωση της γεωμετρίας του μοντέλου
στα σημεία εφαρμογής των οριακών συνθηκών. Έτσι, είναι σημαντικό να
τοποθετούμε Rounds σε όποιες ακμές θεωρείται αναγκαίο. Επομένως,
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επιλέγουμε απο την καρτέλα Insert→ Round ή εναλλακτικά το εικονίδιο
(Round Tool).

Εικόνα Βʹ.8: Δημιουργία Extrude 3.

Από το παράθυρο καθορισμού
του Round μπορούμε να καθορί-
σουμε τις ιδιότητες που θα έχει
το συγκεκριμένο χαρακτηριστικό.
Επιλέγουμε τις τέσσερις ακμές
στο επάνω μέρος των τοιχωμάτων
της γέφυρας καθώς και τις ακ-
μές στις εσοχές και εφαρμόζουμε
το Round. Για να επιλέξουμε πε-
ρισσότερες απο μία ακμές αρκεί
να επιλέξουμε την πρώτη και κρα-
τώντας πατημένο το πλήκτρο Ctrl
του πληκρολογίου, επιλέγουμε και
τις επόμενες. Δίνουμε την τιμή 2 η
οποία είναι η ακτίνα στρογγύευσης της κάθε ακμής.

Με την ολοκλήρωση των Rounds παρουσιάζεται το τελικό μοντέλο
της γέφυρας το οποίο στη συνέχεια θα εισαχθεί για άλλη μια φορά στο
ABAQUS/CAE και θα εφαρμοστούν πάλι οι ίδιες φορτίσεις και οριακές
συνθήκες (πάκτωση στις στηρίξεις), με σκοπό να γίνει η επαλήθευση
του μοντέλου και να μελετηθούν οι παραμορφώσεις που υφίσταται. Το
τελικό σχέδιο παρουσιάζεται στην Εικόνα Β΄.9

Εικόνα Βʹ.9: Τελικό σχέδιο γέφυρας.



Παράρτημα Γʹ

Επαλήθευση
βελτιστοποιημένου μοντέλου

Εικόνα Γʹ.1: Εισαγωγή βελτιστοποιη-
μένου μοντέλου στο ABAQUS/CAE.

Αρχικά δημιουργούμε μια νέα
εργασία από την καρτέλα File
→ New εισάγουμε το .stp αρ-
χείο που προέρχεται από το Creo
Parametric, επιλέγοντας File →
Import από την κεντρική καρτέλα
του ABAQUS/CAE. Παρατηρούμε
ότι στο Model Tree, αν προεκτεί-
νουμε το μενού Parts, έχει τοπο-
θετηθεί το όνομα του αρχείου που εισάγαμε δημιουργώντας έτσι αυτό-
ματα ένα καινούργιου part. Η διαδικασία που ακολουθούμε στα επόμενα
Modules παραμένει η ίδια με την μοντελοποίηση της γέφυρας κατά την
τοπολογική βελτιστοποίηση. Έτσι έχουμε:

• Material Module, για τον ορισμό των ιδιοτήτων του υλικού και της
ενότητας στην οποία αναφέρονται.

• Assembly Module, για την τοποθέτηση του μοντέλο σε ένα ενιαίο
σύστημα συντεταγμένων.

• Step Module, για τον ορισμό των βημάτων της ανάλυσης.

• Load Module, για τον ορισμό των δυνάμεων και οριακών συνθηκών.

Με την εισαγωγή μας στο Mesh Module παρατηρούμε ότι το μοντέλο
χρωματίζεται πορτοκαλί (βλ.Εικόνα Γ.2(α')), κάτι που σημαίνει ότι το
ABAQUS/CAE αδυνατεί να δημιουργήσει το πλέγμα πεπερασμένων ση-
μείων, χωρίς τη βοήθεια του χρήστη, λόγω της περίπλοκης γεωμετρίας
του μοντέλου. Από την καρτέλα Seed επιλέγουμε Instance. Στο επόμενο
παράθυρο είναι προεπιλεγμένο το μέγεθος του στοιχείο το οποίο θα
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(αʹ) Πορτοκαλί χρωματισμός μοντέλου. (βʹ) Τοποθέτηση κόμβων.

(γʹ) Δημιουργία πλέγματος πεπερασμέ-
νων στοιχείων.

Εικόνα Γʹ.2: Διαδικασία δημιουργίας πλέγματος πεπερασμένων στοιχείων.

χρησιμοποιήσει το ABAQUS/CAE για να τοποθετήσει τους κόμβους για
τη δημιουργία του πλέγματος. Αν θέλουμε περισσότερη ακρίβεια μπο-
ρούμε να μικρύνουμε το μέγεθος αυτό, δημιουργώντας έτσι περισσότερα
στοιχεία αν περιοχή. Για να επιλέξουμε τον τύπο του στοιχείου από την
καρτέλα Mesh επιλέγουμε Element Type. Στη συνέχεια, επιλέγουμε Mesh
→ Control για να καθορίσουμε την τεχνική που θα χρησιμοποιηθεί για
τη δημιουργία του πλέγματος. Θα επιλέξουμε μια ελεύθερη τεχνική, χα-
ρακτηριστικό της οποίας είναι ο ρόζ χρωματισμός του μοντέλου κατά
την επιλογή της. Τελευταίο στάδιο της διαδικασίας είναι η δημιουργία
του πλέγματος, επιλέγοντας Mesh → Instance και επιβεβεαιώνουμε την
επιλογή μας από την περιοχή μηνυμάτων.

Mετά την ολοκλήρωση του πλέγματος είμαστε έτοιμοι να υποβάλ-
λουμε την εργασία πρός ανάλυση. Όπως είναι αναμενόμενο δεν θα χρη-
σιμοποιήσουμε καθόλου το Module Optimization, εφόσον βρισκόμαστε
στο στάδιο της επαλήθευσης και ενδιαφερόμαστε για την ανάλυση του
βελτιστοποιημένου μοντέλου και την παρουσίαση της κατανομής των τά-
σεων σε αυτό. Έτσι, από το Model Tree κάνουμε διπλό click στο μενού
Jobs και το παράθυρο δημιουργίας της εργασίας ανάλυσης εμφανίζεται.
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Στο σημείο αυτό μπορούμε να δώσουμε όνομα, καθώς και μια περιγραφή
της εργασίας που πρόκειται να υποβληθεί πρός ανάλυση. Είναι πιθανό
ορισμένες φορές να εμφανίζονται λάθη στην μοντελοποίηση, λόγω λανθα-
σμένων ή ελλειπόντων δεδομένων, γεγoνός το οποίο μπορεί να οδηγήσει
στην αλλοίωση των αποτελεσμάτων ή στην μη υποβολή της εργασίας.
Επομένως, θα πρέπει να πραγματοποιείται έλεγχος των δεδομένων αυ-
τών για την ορθότητά τους. Έτσι, από το Model Tree προεκτείνουμε το
μενού Jobs, κάνουμε δεξί click στην εργασία που δημιουργήσαμε πα-
ραπάνω και επιλέγουμε Data check. Κατά την υποβολή της εργασίας
πρός έλεγχο, αρχικά θα πραγματοποιηθεί ένας έλεγχος των δεδομένων
και στη συνέχεια της κύριας ανάλυσης του μοντέλου. Παρατηρούμε ότι
δίπλα από το όνομα της εργασίας αναγράφεται μια από τις παρακάτω
καταστάσεις για την ενημέρωση του χρήστη σχετικά με την κατάσταση
της διαδικασίας [20].

• Check Submitted, μόλις γίνει η υποβολή της εργασίας για έλεγχο.

• Check Running, κατά τη διάρκεια του ελέγχου δεδομένων.

• Check Completed, μόλις ολοκληρωθεί ο έλεγχος.

• Submitted, μόλις η εργασία υποβληθεί στην κύρια ανάλυση.

• Running, κατά τη διάρκεια της κύριας ανάλυσης.

• Comleted, μόλις ολοκληρωθεί η κύρια ανάλυση.

• Aborted, στην περίπτωση που το ABAQUS/CAE εντοπίσει λάθη είτε
στα δεδομένα, είτε στην ανάλυση και την ματαιώσει.

Κατά την διάρκεια της ανάλυσης το ABAQUS/Standard ενημερώνει
το ABAQUS/CAE για να επιτρέπει στον χρήστη να παρακολουθεί βήμα
πρός βήμα την εξέλιξη των κύκλων ανάλυσης. Από το Model Tree προε-
κτείνουμε το μενού Jobs, κάνουμε δεξί click στην εργασία που δημιουρ-
γήσαμε παραπάνω και επιλέγουμε Monitor. Στην καρτέλα:

• Log, αναγράφεται η ώρα έναρξης και τέλους της ανάλυσης, που
εμφανίζεται στο .log αρχείο.

• Εrrors και Warnings, αναγράφονται τα λάθη και τυχόν επισημάν-
σεις που εμφανίζονται στο .dat και .msg αρχείο. Αν μια συγκεκρι-
μένη περιοχή δημιουργεί τα λάθη, θα δημιουργηθεί ένα σύνολο που
θα εμπεριέχει την περιοχή και ο χρήστης θα μπορεί να το αναγνω-
ρίσει απο το Visualization Module. Η ανάλυση δεν θα μπορέσει να
υποβληθεί αν δεν διορθωθούν τα λάθη που εντοπίστηκαν.

• Output, αναγράφεται ένα αρχείο για κάθε καταχώρηση δεδομένων
εξόδου, όπως είναι γραμμένο στη βάση δεδομένων.
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• όσο προχωράει η ανάλυση, ενεργοποιούνται οι καρτέλες Data File,
Message File, Status File επιτρέποντας στο χρήστη να επιβλέψει
το εσωτερικό των αντίστοιχων αρχείων. Παρόλο το γεγονός ότι
το ABAQUS ανανεώνει τα δεδομένα στα αρχεία, είναι πιθανό να
μην είναι απόλυτα συγχρονισμένα με αυτά που εμφανίζονται στο
Μonitor.

Επιλέγουμε Dismiss για να κλείσουμε το Monitor. Όταν ο έλεγχος
ολοκληρωθεί χωρίς λάθη μπορούμε να υποβάλλουμε την ανάλυση αυτή
καθ'αυτήν. Για να γίνει αυτό κάνουμε δεξί click στην εργασία από το
Model Tree και επιλέγουμε Continue. Είναι σημαντκός ο έλεγχος των
δεδομένων για να εξασφαλιστεί η ορθότητα των δεδομένων καθώς και
η διαθεσιμότητα του δίσκο και της μνήμης του υπολογιστή, για την ολο-
κλήρωση της διαδικασίας. Ωστόσο είναι δυνατό να συνδυαστεί ο έλεγχος
με την ανάλυση κάνοντας δεξί click στο μενού Jobs από το Model Tree
και επιλέγοντας Submit.

Γʹ.1 Αποτελέσματα.

Εικόνα Γʹ.3: Κατανομή τά-
σεων von Mises στο μο-
ντέλο.

Mόλις ολοκληρωθεί η ανάλυση μπορούμε
να επιβλέψουμε τα αποτελέσματά της κάνο-
ντας δεξί click στο μενού Jobs από το Model
Tree και επιλέγοντας Results. Αυτόματα ει-
σαγόμαστε στο Visualization Module. Μπο-
ρούμε να δούμε τυχόν μετατοπίσεις στο πα-
ραμορφωμένο σώμα επιλέγοντας το εικονί-
διο καθώς και την κατανομή των τάσεων
von Mises, χρωματίζοντας αντίστοιχα το μο-
ντέλο, επιλέγοντας το εικονίδιο . Η κλί-
μακα των τάσεων φαίνεταισ την Εικόνα Γ'.3.
Στον τρισδιάστατο χώρο το μοντέλο εμφανί-
ζεται έντονα παραμορφωμένο λόγω του υψη-
λού συντελεστή κλίμακας (scale factor) που
εφαρμόζεται σαν προεπιλογή από το ABAQUS/CAE ώστε να είναι έντονα
κατανοητό το αποτέλεσμα της παραμόρφωσης από τον χρήστη. Στο συ-
γκεκριμένο μοντέλο ο συντελεστής κλίμακας είναι της τάξεων του 3.439
10􏷨. Στις παρακάτω εικόνες εμφανίζεται το έντονα παραμορφωμένο μο-
ντέλο σε αντιδιαστολή με το απαραμόρφωτο.
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(αʹ)

(βʹ)

(γʹ)

Εικόνα Γʹ.4: Aποτελέσματα.
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